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About this guide

Intent

This installation guide is intended for use by qualified and authorized Agilent 
Technologies service personnel who possess an in-depth service background and have 
received training in the installation of the AssayMAP Bravo Platform.

What this guide covers

This guide describes the following software versions, which are required for the 
AssayMAP Bravo Platform:
• Protein Sample Prep Workbench 3.2
• VWorks Automation Control 13.1.5
Microsoft Excel 2016, which is not included, is required for the reagent volume 
calculators and method setup tools in the Protein Sample Prep Workbench. 

What is new in this revision
 and 

Related guides and where to find them

Checklists

You can find the following checklists on the Agilent AssayMAP Bravo Platform product 
page at https://www.agilent.com/en/products/automation-solutions/protein-sample-
preparation/assaymap-bravo-platform
• Site Preparation Checklist. Specifies the site requirements that must be met before 

installing the AssayMAP Bravo Platform.
• Installation Checklist. Lists the tasks to be performed to install the AssayMAP Bravo 

Platform.
                                                        

Feature and description See…

Added a caution that the 25 µL cartridges 
require a wash station with wide-bore 
chimneys.

“Overview of the hardware 
components” on page 6

Updated the software requirements. “Installing the software” on page 40

Revised the verification procedures to reflect 
changes in Protein Sample Prep Workbench 
v3.2.

“Verifying the installation and 
setup” on page 83

https://www.agilent.com/en/products/automation-solutions/protein-sample-preparation/assaymap-bravo-platform
https://www.agilent.com/en/products/automation-solutions/protein-sample-preparation/assaymap-bravo-platform
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User guides

Printed copies of the following guides are provided with the platform.

The following guides are available as links in the Literature Library page of the Protein 
Sample Prep Workbench and available in the online VWorks Knowledge Base.

To access the VWorks Knowledge Base, do one of the following:
• From within VWorks software, select Help > Knowledge Base or press F1.

• From the Windows desktop, select Start  > Agilent Technologies > 
VWorks Knowledge Base.

• Go to the online VWorks Knowledge Base at www.agilent.com/chem/askb and 
click the link for PDF user guides.

To access the context-sensitive help feature in the VWorks software:

1 In the main window of the VWorks software, click the help button . The pointer 

changes to . Notice that the different icons or areas are highlighted as you 
move the pointer over them.

2 Click an icon or area of interest. The relevant topic or document opens. 

Guide Description

Bravo Platform Unpacking Guide Unpacking instructions for the Bravo Platform

Bravo Platform Safety and Installation Guide Safety guidelines, site specifications, and installation 
procedures

General Safety Guide Safety label descriptions and guidelines for Agilent Automation 
Solutions products.

Guide Description

Bravo Platform User Guide Setting up, operating, maintaining, and troubleshooting the 
Bravo Platform 

AssayMAP Bravo Platform Error Recovery 
Guide

Error messages, and how to handle them

AssayMAP Bravo Platform Labware 
Reference Guide

Labware photo reference and descriptions

AssayMAP Syringe Test Utility User Guide Running a syringe test of the Bravo 96AM Head

AssayMAP Bravo Syringe Replacement User 
Guide

Replacing a defective syringe in the Bravo 96AM Head

96 Channel Wash Station Maintenance 
Guide

Replacing chimneys and troubleshooting problems in a 96 
channel wash station.

VWorks Knowledge Base Creating and editing VWorks protocols and application 
interfaces

http://www.velocity11.com/techdocs/AutomationSolutionsKB13/wwhelp/wwhimpl/js/html/wwhelp.htm


1   Before you start
Safety information

4  AssayMAP Bravo Platform Installation Guide

Service documentation

Agilent field service engineers can find instructions on how to maintain and repair the 
Bravo Platform in the following guides:
• Bravo Platform Service Guide 
• Pipette Head Service Guide
Changes to existing procedures and additional service procedures are published as 
service bulletins and posted in the Support Portal at 
http://intranet.chem.agilent.com/sites/partners/support/default.aspx 

Safety information

Before installing and using the Bravo Platform, make sure you are aware of the potential 
hazards and understand how to avoid being exposed to them. You must be properly 
trained in the correct and safe installation and operation of the device. For details, see 
the Bravo Platform Safety and Installation Guide.
Do not substitute parts or make any unauthorized modifications to the Bravo Platform 
or the supplied safety equipment. 

WARNING
Changing or modifying the Bravo Platform safety equipment may prevent the safe 
operation of the device, invalidate its safety compliance, and lead to personal injury 
or property damage. Any customer who does not use the supplied safety equipment 
or who modifies the supplied safety equipment assumes full responsibility for 
providing an appropriate level of safety for its operators and for providing the 
applicable safety compliance marking and documentation.

http://intranet.chem.agilent.com/sites/partners/support/default.aspx
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• “Overview of the hardware components” on page 6
• “Computer requirements” on page 7
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Overview of the hardware components

The following figure and table show the components of the AssayMAP Bravo Platform, 
which are required for running the AssayMAP protocols.

Figure AssayMAP Bravo Platform components

CAUTION
To avoid a hardware crash and equipment damage, ensure that the wash station 
contains the white wide-bore chimneys when using the 25 µL cartridges. 

Item Required hardware

1 Gripper upgrade

2 Bravo 96AM Head 

3 96AM Wash Station or the later model 96 Channel Wash Station

4 Pump Module 2.0 and two carboys

5 96AM Cartridge & Tip Seating Station

6 Risers, 146 mm

7 STC controller

8 Peltier Thermal Station with custom plate nest

9 Thermal plate insert 

10 Orbital Shaking Station with Control Unit
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Note: The white wide-bore chimneys work for both 5-µL and 25-µL cartridges and are 
standard on wash stations purchased in 2020 onward. The wide-bore chimneys are 
white plastic, whereas the standard-bore chimneys are a semi-clear plastic. For details, 
see the 96 Channel Wash Station Maintenance Guide.
 

In addition to the components listed in the preceding table, the AssayMAP Bravo 
Platform includes:
• Bravo Standard Light Curtain and the emergency-stop pendant shown in the 

following figures
• Computer workstation

Figure Standard configuration with Light Curtain

Figure Emergency-stop pendant

Computer requirements

The software user interface for the AssayMAP applications is optimized for a monitor 
with a resolution of 1920 x 1080 (full HD). For a full list of the computer requirements, 
see the software release notes. 

66.5 cm

52.5 cm

84.3 cm
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Installation workflow for standard configuration

Step For this task... See...

1 Verify that the installation site meets the site requirements.

IMPORTANT Ensure that the laboratory table is not bowed 
and is perfectly flat and rigid. A bowed or wobbly table will 
cause placement errors during protocol execution.

Clear the table of all other material that may interfere with the 
installation.

Bravo Platform Safety and 
Installation Guide

2 Unpack and connect the computer. Manufacturer’s instructions

3 Unpack the Bravo Platform and accessories. 

IMPORTANT Do not remove the y-axis shipping stop from 
the head mount until after you have installed the risers 
(“Installing the Bravo risers” on page 9).

Bravo Platform Unpacking Guide

4 Install the Bravo deck risers. “Installing the Bravo risers” on 
page 9

5 Connect the Bravo Platform power cord, communications 
cable, and pendant cable.

Bravo Platform Safety and 
Installation Guide

6 Install the Bravo 96AM Head. “Before you install the AssayMAP 
head” on page 12

7 Install the 96AM Wash Station and Pump Module. “Installing the Wash Station and 
Pump Module” on page 15

8 Install the standard platepads at the specified Bravo deck 
locations.

“Installing the standard platepads” 
on page 25

9 Install the Peltier Thermal Station and the Inheco STC 
Controller.

“Installing the Peltier Thermal 
Station” on page 26

10 Install the Orbital Shaking Station. “Installing and connecting the 
Orbital Shaking Station” on 
page 31

11 Set up the software, and configure the device files. “Setting up the computer and 
software” on page 35

12 Set the AssayMAP head teachpoints in every one of the 
AssayMAP profiles. Verify the gripper offset in every profile.

“Setting the teachpoints” on 
page 61

13 Install the Bravo shields and Light Curtain. Bravo Platform Safety and 
Installation Guide

14 Verify the installation and setup. “Verifying the installation and 
setup” on page 83
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Installing the Bravo risers 

Before you start

WARNING
The Bravo device weighs approximately 52.1 kg (114.9 lb). Attempting to move the 
Bravo device without assistance could cause personal injury. Request assistance 
and use proper lifting techniques when moving the Bravo device.

CAUTION
Tugging on the tie bar or using it to lift the Bravo Platform can damage the device. Do 
not grab the tie bar when lifting the Bravo Platform.

 

IMPORTANT
The following procedure is intended only for fully qualified and trained Agilent service 
engineers.

Ensure that you have the following:
• Two people to lift the Bravo Platform
• Foam pad (3-inch thick) or similar cushioning material to use when you tilt the 

Bravo Platform onto its back plate
Note: EPE foam is preferred due to its firmness.

• Risers 
• Hex drivers

Procedure

CAUTION
When tilting the Bravo Platform backwards to rest on its back plate, the head mount 
can slide back rapidly along the y-axis and collide with the back plate. To prevent 
potential equipment damage, ensure that the y-axis shipping stop remains installed 
on the head mount until after you install the risers. If the shipping stop has already 
been removed during unpacking, ensure that the head mount is resting against the 
Bravo back plate before tilting the Bravo Platform backwards.

00233
Bravo
Proper lift

00233

00234
Bravo
Improper lift

00234
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To install the risers:
1 Place the foam pad on the work table behind the Bravo Platform.
2 Ensure that the head mount is resting against the Bravo back plate. With a person 

positioned on each side of the Bravo Platform, slowly tilt the device backwards until 
the back plate rests on the foam. 

3 Remove the four rubber feet from the base of the Bravo deck. 

Figure Bottom view of Bravo deck

4 On the bottom of the Bravo deck, install the two risers, one on each side. Use the 
four screws and washers provided to install each riser. Tighten the screws as 
follows:
a Tighten the screws at the top first, and then tighten the screws at the bottom, 

as the following figures show.
b Tighten the screws until snug, and ensure that the risers are flush to the base of 

the Bravo deck.

Figure Top screw located at inner hole
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Figure Bottom screw located at outer hole

5 Ensure the risers are installed securely, and the outside edges of the risers are 
flush with the Bravo base.

6 Lift the Bravo Platform up onto the risers using proper lifting techniques.

WARNING
Attempting to lift the Bravo device without assistance could cause personal injury 
and result in equipment damage. Request assistance and use proper lifting 
techniques when lifting the Bravo device.

Figure Bravo Platform on risers with no deck platepads

Ensure that the instrument and riser assembly does not wobble and that it sits flat 
on the table. If the Bravo Platform has any wobble or the risers have uneven 
seating, replace or realign and tighten the risers.
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Ensure that you provide 30.48-cm (12-inch) clearance behind the Bravo Platform.

IMPORTANT
Make sure that you remove the y-axis shipping stop from the Bravo head mount. For 
instructions, see the Bravo Platform Unpacking Guide.

IMPORTANT
Before you install any platepads or accessories, use a clean lint-free cloth to wipe the 
Bravo deck and ensure that it is clean. 

Before you install the AssayMAP head

About the tip-box stripper pins

The Bravo 96AM Head has four retractable tip-box stripper pins, two on each side of the 
probes, as the following figure shows. Before you install the Bravo 96AM Head, ensure 
that the tip-box stripper pins are retracted, as the following figure shows. 

Figure Bravo 96AM Head (upside down) with stripper pins retracted

If necessary, perform the following procedure to retract the stripper pins.
For instructions on how to install the Bravo 96AM Head, see the Bravo Platform Safety 
and Installation Guide.

CAUTION
If the tip-box stripper pins are extended, the pins will crash into the wash station 
during syringe washing. To prevent potential equipment damage, ensure that the pins 
are always retracted during use.
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Figure Bravo 96AM Head with tip-box stripper pins retracted (left) and extended (right)

Removing the head from the storage stand

To remove the head from the storage stand:
1 Ensure that the top of the head is resting on a clean, stable surface. The probes 

should be facing upward, as the following figure shows.
2 Using both hands, carefully lift the stand off of the head while guiding the stand’s 

side cutouts (1) off the head side tabs (2). Use care to avoid touching the probes.

Figure Removing or inserting the stand on the Bravo 96AM head

                                                        

1

2
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Retracting the tip-box stripper pins

To retract the tip box stripper pins:

CAUTION
If you apply too much force when pressing down or rotating the pin to retract it, the 
locking mechanism at the tip of the pin can bend or break. A damaged pin cannot 
lock in the retracted position. Use only gentle pressure to push down and rotate the 
pin to lock it into place.

1 Place the Bravo 96AM Head upside down on a stable surface, so that the probes 
are facing up and the front of the 96AM Head (logo side) is facing you.
If directional arrows appear on the pins, gently rotate the pins so that the arrows are 
facing you.

2 Insert the end of a 2-mm hex wrench into the head of one of the pins, and very 
gently push the pin down into the pipette head until you feel the pin stop. 
Verify that the pin is properly seated. If the pin has an arrow, the square end of the 
arrow should disappear or be barely visible.

IMPORTANT
If the pin hits a stop before it retracts completely, the pin locking mechanism is above 
instead of below the locking dowel. While removing any downward pressure on the pin 
head, gently rotate the pin in quarter-turn increments until you feel the pin drop into the 
seated position.

3 When the pin is properly seated, rotate it counterclockwise no more than 180° until 
it locks.

4 Repeat this procedure for the other pins.
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Installing the Wash Station and Pump Module

The AssayMAP Bravo Platform requires one of the following wash station models:

Before you start

CAUTION
To prevent a potential collision, ensure that the wash station has the wide bore 
chimneys when using the 25 µL cartridges. 

Use the following workflow.

Wash station name, 
Agilent part number 
(internal part number)

 Description AssayMAP cartridge compatibility

96 Channel Wash 
Station, G5498B#90  
(G5409-60125)

Equipped with 96 white, 
wide-bore chimneys and a 
bracketed platepad to 
secure it. 

5 µL or 25 µL cartridges

96AM Wash Station, 
G5498B#57 
(11961-311)

Equipped with 96 
chimneys and a bracketed 
platepad to secure it. 

5 µL cartridges 

If the site plans to use the 25 µL cartridges, this wash 
station must be retrofitted with the white, wide-bore 
chimneys (part number G5409-68004). The wide-bore 
chimneys are white plastic, whereas the normal-bore 
chimneys are a semi-clear plastic. 
For details on how to retrofit this wash station with the 
wide-bore chimneys, see the 96 Channel Wash Station 
Maintenance Guide.

Step For this task... See...

1 Ensure that the wash station chimneys are in 
good condition.

“Wash station inspection” on page 16

2 Install the bracketed platepad and the 96AM 
Wash Station at deck location 1.

“Installing the Wash Station and Pump 
Module” on page 15

3 Set up the tubing configuration. “Tubing connections for wash station” on 
page 19

4 Connect the tubing and the Pump Module 
power and communication cables.

“Routing the tubing” on page 21
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Wash station inspection

Carefully inspect the chimneys in the wash station to ensure that they are:
• In good condition and free of deformities. The chimneys must not be damaged, 

such as those shown in the figure (possibly from a head collision).
• Of equal height. When the chimneys are fully seated in the wash station their height 

should be consistent (less than 1 mm difference in height).
If any chimney is taller than the others, use your thumb to press down on the 
chimney so that it touches the bottom surface (hard stop) of the wash station. Use 
care when seating the chimney to avoid damaging it.

Good condition chimneys and consistent chimney height are critical for proper wash 
station function. To replace damaged chimneys, see the 96 Channel Wash Station 
Maintenance Guide. 

Figure Close up views of wash station chimneys 

                                                        

Good condition chimneys Damaged chimneys

Standard-bore chimneys

Wide-bore chimneys
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Installing the wash station

Before you start

WARNING
To prevent potential injury, turn off the Bravo Platform before you install or remove 
any accessory.

Ensure that you have the following:
• Wash station and the platepad with brackets
• Pump Module 2.0 
• Tubing kit with inline filter
• Hex driver for 2-mm screws
Ensure that you install the wash station at deck location 1.

Figure Wash station installed at deck location 1

To install the wash station:
1 At deck location 1, install the bracketed platepad. Use the supplied screw to secure 

the platepad to the deck.
Ensure the platepad crosshairs are oriented towards the northwest corner of the 
deck, as the following figure shows.
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Figure Deck location 1 (top view) showing crosshairs orientation

2 On the platepad side that is next to the crosshairs, use a hex driver to uninstall the 
two 2-mm screws and remove the bracket. 
Note: The wash station is easier to install if you remove the outer bracket, and 
then replace the bracket after the wash station is in position.

Figure Bracket next to platepad crosshairs

3 Install the wash station on the platepad as follows:
a Ensuring that the inlet and outlet ports are towards the rear of the deck, place 

the wash station on the platepad.
b Guide the platepad inner bracket into the wash station’s horizontal side slot.
c Re-install the bracket that you removed in step 2 on the outer side of the 

platepad. Ensure that you guide the bracket into the corresponding horizontal 
slot on the wash station. Ensure that both brackets remain engaged as you 
tighten the bracket screws.

d Ensure that the wash station sits level on the platepad and that both brackets 
are holding the wash station securely in place. 

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
00240Front
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Figure Wash station secured with platepad brackets

Tubing connections for wash station

The following figure shows the AssayMAP Bravo tubing connections for the wash 
station. As the figure shows, the upper pump (A) is for the fill line and the lower pump 
(B) is for the empty line. 
Note: You specify which pump is for filling and which pump is for emptying in Bravo 
Diagnostics.

Figure 96AM Wash Station fill line (A) and empty line (B)

To ensure proper chimney filling and waste emptying characteristics for the wash 
station, ensure that you use the proper tubing combination for the Pump Module. See 
the following figure and table.

A

B
Source Waste
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Figure Tubing configuration
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Item Component Description

1 Source bottle Supplies the fill liquid for the wash station.

2 Waste bottle Collects the waste liquid that is pumped from the reservoir.

3 Tubing, 8-mm (5/
16-in)

The length of tubing in the lower pump head, which is used for emptying the 
wash station. The larger diameter tubing ensures that the fluid is removed 
efficiently from the wash station

4 Tubing, 6.4-mm 
(1/4-in)

The fill-line tubing from the source bottle to the wash station, and empty-line 
tubing connections on either side of the 5/16-in diameter tubing. 
Note: The 5/16-in diameter tubing is too large for the quick-disconnect fittings 
and the wash station ports. So, you use a union connector (5) to splice the 5/16-
in tubing to the 1/4-in tubing.

5 Connector, union Joins the two sizes of tubing. 

6 Quick-disconnect 
fitting

Enables easy removal of the wash station and quick replacement of the tubing in 
the pump heads. The quick-disconnect fittings include an automatic-close valve. 
Fluid can flow only if a positive connection is made.

7 Inline pump filter Removes the particulates that can clog the chimneys in the wash station.

8 3-way connector Enables one tube to branch into two tubes at the input and output ports on the 
wash station.

9 Quick-disconnect 
fitting

Acts as a vent to prevent pressure or vacuum from building up inside the bottle.
Plug a quick-disconnect in the open hole in each bottle. If an extra quick-
disconnect fitting is not available, loosen the lid to allow air to vent.
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Routing the tubing

Refer to the preceding table and figure, and use the following procedure to route the 
wash station tubing. 

To route the tubing:
1 Prepare two 3-way (Y-connector) tubing assemblies and connect them to the wash 

station, as follows:
a Cut two 10.16-cm (4-inch) lengths of the 1/4-inch tubing, and place one length 

each on two of the three barbed ends of a 1/4-inch 3-way connector (a). Cut a 
third length of tubing to attach to the third barbed end of the 3-way connector.

b Attach the two free ends of the prepared 3-way tubing assembly to the wash 
station outlet ports, as the following figure (b) shows. 

 

c Repeat step a to create a second 3-way tubing assembly, and attach it to the 
wash station inlet ports (c). Secure the tubes on the inlet ports using tubing 
clamps. 

2 For the top pump, prepare an approximately 20.32- to 25.4-cm (8- to 10-inch) 
length of 1/4-inch tubing, and insert quick-connect fittings on both ends. 

3 Place this tubing assembly within the top pump head, as follows:
 

a Lift up the flip-top cover on the pump head so that it is fully open.
b On each side of the open pump head, turn the dial to open the clamps 

(V-grooves) fully to accommodate the diameter of the tubing. 

a
b

c

00306
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Figure Open pump head (side view) with fully open clamp and clamp dial 

c Insert the length of tubing so that it gently arches over the rollers. Ensure the 
tubing is located in the center of the tube clamps (V-grooves) on either side of 
the pump head, and then carefully lower the cover.

CAUTION
Ensure that the pump head clamps are set properly for the diameter of the tubing. 
Incorrectly adjusted clamps can constrict the flow or damage the tubing when the 
pump head is closed.

Note: If any creeping of the tubing occurs during operation, tighten the clamps 
slightly using the clamp dials.

4 For the bottom pump:
a Prepare an approximately 20.32- to 25.4-cm (8- to 10-inch) length of 5/16-inch 

tubing, and insert a union connector (figure, a) on each end. 
b Connect a 10.16-cm (4-inch) length of 1/4-inch tubing (b) to each of the union 

connectors.
c Connect quick-disconnect fittings (c) to the free end of each 1/4-inch tubing 

section. 
d Place this tubing assembly within the bottom pump head. Refer to step 3 for 

the detailed procedure.
 

                                                        

00306

a b c
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5 Connect the tubing from the Pump Module to the wash station tubing as follows:
a Cut two lengths of the 1/4-inch tubing, approximately 61- to 91.4-cm  

(2- to 3-foot) long each. 
b Connect one of these tubing sections to the tubing assembly from the bottom 

pump (outlet line).
c Cut the remaining length of tubing (from step a) in the middle, and install the 

inline pump filter onto the cut ends. Connect this tubing assembly to the top 
pump (inlet line).

IMPORTANT
Ensure that the filter is oriented so that the three thumbscrews face toward the Pump 
Module.   

d Connect the inlet and outlet lines from the Pump Module to the corresponding 
lines on the wash station.

6 Connect the tubing from the Pump Module to the source and waste carboys as 
follows:
a Prepare the source carboy:

Cut a length of the 1/4-inch tubing measured for the distance from the source 
bottle to the Pump Module. Allow plenty of slack in the tubing.
Place the appropriate quick-disconnect fitting on each end on this tubing. 
Connect one end of the tubing to the output port of the source carboy and 
connect the other end to the tubing assembly in the top pump (inlet line).

b Prepare the waste carboy:
Cut a length of the 1/4-inch tubing measured for the distance from the waste 
carboy to the Pump Module. Allow plenty of slack in the tubing.
Place the appropriate quick-disconnect fitting on each end on this tubing. 
Connect one end of the tubing to the output port of the waste carboy, and 
connect the other end to the tubing assembly in the bottom pump (outlet line).

                                                        

00306



2   Installing the platform
Installing the Wash Station and Pump Module

24  AssayMAP Bravo Platform Installation Guide

c Use the fitting provided in the tubing kit to vent the carboys as the following 
figure shows. The vent prevents pressure or vacuum from building up inside 
the bottle.

Connecting the Pump Module

To connect the Pump Module:
1 At the Bravo rear connector panel, connect the Pump Module RJ-45 cable to the 

Pump I/O port (1), as the following figure shows. Connect the other end of the cable 
to the COM IN port (2) on the rear of the Pump Module.

2 Connect the Pump Module power cord between the AC connector on the Pump 
Module and an AC outlet with a grounded circuit.
For detailed installation instructions, see the Pump Module User Guide.

00220
Bravo
Back

00
22

0c

100V-240V
50/60Hz
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Installing the standard platepads

The platepad has a crosshairs for setting the pipette head teachpoints in one corner, as 
the following figure (1) shows.

Install the standard platepads at the Bravo deck locations specified for your 
configuration. The standard configuration uses platepads at deck locations 2, 3, and 
5–8.

Before you start

Make sure you have the following:
• Platepad
• Flathead cap screw, M6 x 40 mm 

Procedure

To install a platepad:
1 With the crosshairs toward the back side of the device, align the pins in the bottom 

of the platepad with the holes on the deck. 
Make sure the pins are inserted correctly and the accessory sits level on the deck. 

2 Secure the platepad to the deck using the screw provided.
3 Ensure that the setscrews in the platepad tabs are recessed and not protruding 

into the plate nest. Use a 1.5-mm hex wrench to back out any protruding 
setscrews.

00240
Bravo
Plate Orientation

1 2 3
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7 8 9
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IMPORTANT
A protruding setscrew will prevent proper seating of the labware in the platepad. 

Figure Setscrew in platepad tab

Note: You will verify the deck configuration in the corresponding Bravo profile and set 
the teachpoint for the deck location in a subsequent procedure.
 

Installing the Peltier Thermal Station

To accommodate the height of the Peltier Thermal Station below the Bravo deck, risers 
are required. The Peltier Thermal Station is too tall to sit at deck level and must be 
installed in a deck cutout. The following figure shows the assembled Peltier Thermal 
Station with the custom plate nest.

Figure Assembled Peltier Thermal Station with custom plate nest 

Before you start

CAUTION
Ensure that the connector end of the cable on the Peltier Thermal Station does not 
knock against the metallic table top or other areas as it could get permanently 
damaged. Handle the Peltier Thermal Station cable with care during all stages of 
installation.

Ensure you have the following:
• Peltier Thermal Station assembly (including four M2.5 bolts and one M3 flathead 

cap screw)
• Hex drivers 
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• Inheco STC Controller, power and communication cables, and Inheco user 
documentation for the STC Controller 

Carefully handle the cable of the Peltier Thermal Station during removal from the box, 
as the following figure shows. 

Use the following workflow.

Installing the Peltier Thermal Station in the Bravo deck

Use the following procedure to install the Peltier Thermal Station at deck location 4.
 

To install the Peltier Thermal Station:
1 Uninstall the platepad, if applicable, from deck location 4.

To uninstall a platepad, remove the M6 flathead screw from the center of the 
platepad. Remove the platepad from the deck.

2 Remove the cutout cover. Use a hex driver to uninstall the four M3 screws that 
attach the cutout cover to the deck.

Figure Cutout cover on the Bravo deck

                                                        

Step For this task... See...

1 Install the Peltier Thermal 
Station.

“Installing the Peltier Thermal Station in the 
Bravo deck” on page 27

2 Connect the STC Controller. “Connecting the STC controller” on page 30
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3 Uninstall the plastic interface from the top of the Peltier Thermal Station by 
removing the four screws located at the four corners.

Figure Plastic interface on the top of the Peltier Thermal Station assembly

Figure Peltier Thermal Station assembly with plastic interface removed

4 Perform the following steps to place the Peltier Thermal Station assembly into the 
cutout hole, and then position the bracket:

Figure Bracket, Peltier Thermal Station assembly, and deck cutout

a Carefully slide the cable into the cutout hole first before you place the Peltier 
Thermal Station assembly into the cutout. 
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b Ensure that the safety label  faces the front of the Bravo deck.

c Press and hold from the bottom to squeeze in the metal as you insert the 
Peltier Thermal Station assembly into the hole.

d Position the bracket over the top of the assembly, and ensure the bracket is 
seated on the deck surface.

e If there is slight resistance when fitting the assembly into the cutout or when 
positioning the bracket, you may use a rubber mallet to tap the metallic base or 
bracket into place. 

CAUTION
Using too much force with a rubber mallet can damage the Peltier Thermal Station.

Figure Tapping the Peltier Thermal Station bracket in place

f Ensure that the Peltier Thermal Station sits flush in the cutout and that the 
bracket is seated on the Bravo deck.

5 Use a hex driver to install the four M2.5 bolts that secure the bracket to the deck.

Figure Securing the Peltier Thermal Station to the deck
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6 Install the custom plate nest on the top of the Peltier Thermal Station as follows:
a Orient the plate nest so that the crosshairs (+) is towards the back of the deck.
b Position the plate nest and ensure that it is fully seated. 
c Install the M3 screw in the center of the plate nest to secure it to the Peltier 

Thermal Station.

Figure Installing the custom plate nest

7 Connect the cable from the Peltier Thermal Station to the Inheco STC controller.
 

Connecting the STC controller

The following figure shows the Inheco STC Controller.

Figure STC Controller front and rear views

To connect the STC Controller:
1 Install the CPAC communications board in the STC Controller.

CAUTION
The communication boards can be damaged by electrostatic discharge. Only 
individuals qualified to handle ESD devices should perform this procedure. Ensure 
that you follow all antistatic precautions while installing the boards in the controller.

Three screws secure the access panel cover to the STC Controller. Ensure that the 
board locks into its slot connector in the STC Controller. For more details on the 
STC Controller, see the Inheco user documentation.

2 Connect the STC Controller to the computer using the provided USB cable. 
3 Connect the STC Controller power cable to an AC outlet.
4 Set the controller power switch to the On (|) position.

USB

ID

ext.
Sensor

CCPCPCPCPPAACACACACACC
22121212121 555.5.555°°C°C°C°CC
11010101000000000000rprprprprprppmmmmm
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Installing and connecting the Orbital Shaking Station

The following figure shows the Orbital Shaking Station, which has its own control 
module.

Figure Orbital Shaking Station with control module and adapter pad

For a full description of the Orbital Shaking Station, see the manufacturer’s 
documentation.

Before you start 

Make sure you have the following:
• Orbital Shaking Station and the control module
• Adapter pad (supplied with the Orbital Shaking Station) 
• Hex drivers
• M6 x 12-mm flathead screw that holds the adapter pad to the deck (supplied with 

the Orbital Shaking Station) 
• Two M3 x 18-mm socket-head cap-screws that attach the Orbital Shaking Station 

to the adapter pad (supplied with the Orbital Shaking Station)
Use the following procedure to install the Orbital Shaking Station at deck location 9. 
Ensure that no platepad is installed at deck location 9. If necessary, uninstall the 
platepad by removing the M6 screw in the center of the platepad.

Figure Deck locations (top view)
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Installing the Orbital Shaking Station

To install the Orbital Shaking Station:
1 Position the adapter pad at the designated deck location, aligning the dowel pins 

with the corresponding holes in the deck.
Make sure the adapter pad sits level on the deck.

2 Insert the M6 x 12-mm flathead screw into the center of the adapter pad and 
tighten the screw. 

3 Place the Orbital Shaking Station atop the adapter pad so that the cable is towards 
the back of the Bravo deck. 
Make sure the station is completely centered on top of the adapter pad and sits 
level.

4 Insert the two M3 x 18-mm socket-head cap screws into the holes at the front and 
back end of the adapter pad and use a 2.5-mm hex driver to tighten the screws. 
Tighten the screws evenly to ensure the feet on the bottom of the Orbital Shaking 
Station are pressed evenly into the adapter pad, and the station remains level.
Note: The feet of the Orbital Shaking Station are compressible, and these screws 
do not reach a hard stop as a result.

CAUTION
The Orbital Shaking Station can shift slightly when tightening. Ensure that the sides 
of the Orbital Shaking Station are parallel to the sides of the adapter plate. If the 
Orbital Shaking Station is rotated, it could cause the Bravo gripper to collide with the 
accessory. 
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Connecting an Orbital Shaking Station

To connect an Orbital Shaking Station with its own control module:
1 Route the Orbital Shaking Station cable off the deck and connect it to the control 

module that contains the power plug. See following figure, item 1.

2 Connect the serial cable with the red stripe to the leftmost port on the control 
module (figure, item 2). Connect the other end of the cable to the serial port, if 
available, on the controlling computer.

IMPORTANT
Connecting the Orbital Shaking Station to a serial port on the computer provides more 
reliable communication than using a USB-to-serial adapter. If a serial port is not 
available, use a USB-to-serial adapter.

3 On the control module, ensure that the knob is turned fully counterclockwise so 
that the red arrow (3) is pointing to the RS-232 setting.

4 Connect the control module power connector (4) to an AC outlet with a grounded 
circuit.

5 Turn on and test the Orbital Shaking Station as follows:
a On the control module, turn the knob clockwise to the maximum position, and 

verify that the Orbital Shaking Station vibrates. 
b Slowly, turn the knob back counterclockwise to the minimum position until the 

station stops vibrating but is not fully off.
6 Place the pipettor teaching plate on the Orbital Shaking Station. Verify that the 

plate fits within the four corner tabs but has no extra space. 

Figure Pipettor teaching plate

If necessary, use the supplied hex driver to adjust the fit of the four corner tabs. Do 
not overtighten.
Alternatively, you may use a sample microplate instead of the teaching plate.

12

3

4
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Note: Before the accessory is ready for use, you will verify the deck configuration in the 
corresponding Bravo profile and set the teachpoint for the accessory location.
 

Using a USB-to-serial connection

If you are using a USB-to-serial connection, complete the set up as follows.

To complete the set up for the USB-to-serial connection:
1 If a driver is required, install the appropriate driver. Follow the instructions on the CD 

supplied with the USB adapter.
2 Write down the COM port assignment for the Orbital Shaking Station. See the 

following procedure for instructions.
The computer auto assigns the COM port for the connection, which may be 
different than the COM port specified in the AssayMAP profiles. To resolve 
conflicts, you may do either of the following:
• Update the settings in the AssayMAP profiles to match the new COM port 

assignment.
• Use the Device Manager to reassign the COM port so that the number matches 

the settings in the AssayMAP profiles.

IMPORTANT
The COM port assignment must be 9 or lower. Otherwise, the AssayMAP Bravo 
Platform will not recognize the connection.

To view the current COM port assignments:
1 From the Microsoft Windows desktop, open the Device Manager. The Device 

Manager can be accessed from the Control Panel. For detailed instructions, see the 
Microsoft Windows user documentation.

2 In the Device Manager, expand Ports (COM & LPT). The list of COM ports appear.

Figure Ports (COM & LPT) area of the Device Manager window 



35

3 Setting up the computer and software
• “Setting up the computer and installing the software” on page 36
• “Turning on the platform and setting up the VWorks software” on page 41
• “Verifying the profile settings and configuration” on page 43
• “About verifying the deck configuration in the profile” on page 47
• “Verifying the Autofill Station configuration (wash station)” on page 49
• “Verifying the Peltier Thermal Station configuration” on page 51
• “Verifying the Orbital Shaking Station configuration” on page 53
• “Initializing the profile that you are verifying” on page 55
• “Testing the accessories” on page 56
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Setting up the computer and installing the software

Setting up the computer

For computer requirements, see the software release notes.
If the Agilent-supplied computer is being set up for the first time, you must set up the 
Microsoft Windows operating system.

To set up a new Agilent-supplied computer:
1 Turn on the computer and monitor. An automated setup procedure runs to prepare 

the computer. 
2 When the Set Up Windows wizard opens, enter the requested information in each 

screen based on the customer’s preferences.
3 Ensure that Microsoft Excel 2016 or later version is installed. 

Note: Microsoft Excel is required for the Protein Sample Prep Workbench 
calculators. Agilent Technologies does not supply Microsoft Excel. 

Turning on the instrument

To turn on the AssayMAP Bravo Platform:
1 Ensure that the Bravo Platform is connected according to the instructions in the 

Bravo Platform Safety and Installation Guide.
2 To turn on the Bravo instrument, press the power switch to the on (|) position.

The green light on the switch is illuminated when the Bravo Platform is on.
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Setting up the computer LAN

WARNING
Connecting the Bravo Platform to a company or general network can potentially 
cause injury. Remote computer operators might accidentally initiate an operation 
that causes the robot to move unexpectedly, possibly injuring nearby lab personnel. 
Avoid connecting the Bravo Platform to a company or general network. Ensure that 
anyone with access to the Bravo Platform is trained in the potential hazards and how 
to avoid them.

IMPORTANT
Verify the LAN connection to the instrument before connecting to any other networks. 
If the computer will be connected to the house LAN, make sure the computer has a 
second network adapter. The second network adapter can have a dynamic IP address.

To set up the computer LAN:
1 From the Windows desktop, go to Control Panel > Network and Sharing Center. 
2 In the Network and Sharing Center window, locate and click Sub Network or Local 

Area Connection, as applicable.
Note: Depending on the setup, the name of the network can vary, for example, 
instead of Sub Network, it might be Local Area Connection. 
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3 In the Sub Network Status or Local Area Connection Status dialog box that opens, 
click Properties. 

4 In the Properties dialog box, do the following:
a Clear the check box of Internet Protocol Version 6 (TCP/IPv6).
b Select Internet Protocol Version 4 (TCP/IPv4).
c Click Properties.

Figure Local Area Connection Properties dialog box

Note: The name of the Ethernet adapter can vary depending on the computer 
model.
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5 In the Internet Protocol Version 4 (TCP/IPv4) dialog box:
a Select Use the following IP address. 

b In the IP address boxes, type the following:
192.168.0.1. 

IMPORTANT
The specified static IP address is required for the connection.

c Press the TAB key. The subnet mask populates automatically to display the 
following:
255.255.255.0

d Click OK.
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Installing the software

Install the following software versions (or later) using one of the following procedures:

To install the software on a computer that contained previous versions of the VWorks 
and Protein Sample Prep Workbench software:
1 Create backup copies of the following items for safekeeping:

• Copy the Workbench folder at C:\VWorks Workspace\Workbench.
• Export the full set of Velocity11 registry keys.

2 Uninstall any previous versions of the following software:
• Protein Sample Prep Workbench or AssayMAP Launch Pad
• VWorks software
Note: In Microsoft Windows 10, go to Settings > Apps & features, select the name 
of the software application, and then click Uninstall. 

3 See the AssayMAP Protein Sample Prep Workbench Upgrade Guide for a detailed 
procedure of how to install the VWorks software and the Protein Sample Prep 
Workbench.

To install the software on a new (clean) computer:
1 See the VWorks release notes for the VWorks installation instructions. The 

software installation also includes the following:
• Agilent Software Verification Tool
• Agilent Bravo IQOQ Test Utilities

2 Follow the instructions in the release notes for the Protein Sample Prep Workbench.

Software Version 

VWorks Automation Control 13.1.5

Protein Sample Prep Workbench 3.2
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Turning on the platform and setting up the VWorks software

Before you start

You must set up the AssayMAP Bravo Platform in the VWorks software before you can 
safely run the protocols in the Protein Sample Prep Workbench. Make sure that you 
perform the following steps in the order given to set up the AssayMAP Bravo Platform.

WARNING
To avoid potential injury and damage to the device, only personnel trained in how to 
teach the AssayMAP Bravo Platform should perform the setup procedures.

Workflow

Turning on the AssayMAP Bravo Platform

To turn on the platform:
1 If you have not already done so, turn on any accessories, such as the Pump 

Module. If applicable, ensure that the Inheco STC Controller and the control 
module for the Orbital Shaking Station are turned on.

2 Turn on the computer, and start the Microsoft Windows operating system.
3 On the side of the AssayMAP Bravo Platform, press the power switch to the on (|) 

position.

Step For this task... See...

1 If you have not already done so, 
turn on the AssayMAP Bravo 
Platform.

“Turning on the AssayMAP Bravo 
Platform” on page 41

2 Understand the device profile 
requirements

“Device profile requirements” on 
page 42

3 Start the VWorks software, 
establish communication with 
the device, and then verify the 
device profile settings for this 
installation.

“Verifying the profile settings and 
configuration” on page 43
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Device profile requirements

Each AssayMAP application requires a specific Bravo device file and profile. The device 
profile specifies the head type (Bravo 96AM Head), Ethernet communication settings 
for the device, the configuration of the platepads and accessories on the deck, and the 
associated teachpoints for the specific combination of instrument and Bravo 96AM 
Head.
Each device profile is associated with a device file. The following table lists the device 
files and associated profiles installed with the Protein Sample Prep Workbench v3.2. 

Table AssayMAP device files and associated profiles

Device file name Profile name AssayMAP applications 

AssayMAP Bravo.dev AssayMAP 1 profile Affinity Purification
Affinity Purification: Aspiration Mode
Immobilization

GlykoPrep-Plus_AM Bravo.dev GlykoPrep-Plus profile N-Glycan Sample Prep applications

AM Peptide Sample Prep.dev AssayMAP Peptide Sample 
Prep profile

Fractionation
IMAC Cartridge Customization
In-Solution Digestion: Multi-Plate 
On-Cartridge Reaction
Peptide Cleanup 
Peptide Cleanup: Aspiration Mode
Phosphopeptide Enrichment 
Protein Cleanup

InSolution Digestion-AM 
Bravo.dev

Single Plate InSolution 
Digestion

In-Solution Digestion: Single Plate 
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The device profile must specify the correct deck configuration and the associated 
teachpoints for the Bravo deck layout. 

IMPORTANT
If other liquid-handling heads will be used on the AssayMAP Bravo Platform, such as a 
96LT Head, ensure that you verify the corresponding device files and profiles for the 
those liquid-handling heads. For details, see the Bravo Platform User Guide.

Verifying the profile settings and configuration

Ensure that you complete the following workflow for all device profiles in the Protein 
Sample Prep Workbench. 

Verifying the profile settings

IMPORTANT
Ensure that the Protein Sample Prep Workbench is closed. 

To verify the profile settings:
1 Start the VWorks software.

You can click the VWorks desktop icon or use the Start menu on the Windows 
desktop to start the VWorks software. 

2 Ensure that Simulation is off.

Normalization-AM Bravo.dev AssayMAP Normalization Normalization, Serial Dilution, 
Reformatting
Note: These utilities have a deck layout 
that includes plate risers at deck locations 
2 and 6.

Device file name Profile name AssayMAP applications 

Step For this task... See...

1 Ensure the device file references 
the correct profile and the profile 
settings are correct.

“Verifying the profile settings” on 
page 43

2 Ensure the deck configuration in 
the profile matches the physical 
AssayMAP Bravo deck.

“About verifying the deck configuration 
in the profile” on page 47
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3 In the VWorks window, open the corresponding AssayMAP device file for the profile 
that you are verifying. 
To open a device file, choose File > Open. In the Open dialog box, ensure the file type 
is Device Files (*.dev), select the file, and then click Open.
The device files are installed in the following default location:
C:\VWorks Workspace\Workbench\Device Files

4 Click No when the Would you like to initialize devices now? message appears.

5 In the <name>.dev tab, ensure that the Profile selection is correct. 

If necessary, select the correct name from the Profile list, and then click the Save 
icon. 

Figure AssayMAP Bravo.dev tab and Profile setting for AssayMAP 1 

6 In the <name>.dev tab, click Device diagnostics. The Bravo Diagnostics dialog opens.
7 In the Profiles tab, verify the Profile name. 

Device file name Profile name
AssayMAP Bravo.dev AssayMAP 1 
GlykoPrep-Plus_AM Bravo.dev GlykoPrep-Plus 
AM Peptide Sample Prep.dev AssayMAP Peptide Sample Prep 
InSolution Digestion-AM Bravo.dev Single Plate InSolution Digestion
Normalization-AM Bravo.dev AssayMAP Normalization
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8 Verify the following Head Information properties.

9 In the Connection area, select This Bravo is connected via ethernet, and then click 
Find available device to select the device to associate with the profile. 
In the Discovered BioNet Devices dialog box that appears, perform the following 
tasks:

a Click the Select the Ethernet adapter to use from the list below, and select the 
correct adapter for the device connection.

b In the list of devices that appear, select the Bravo device. If multiple Bravo 
devices are on the network, use the MAC Address to identify the Bravo device 
for this profile. To successfully communicate with the Bravo device, the Status 
column must display New or Matched.

Property Setting
Head type 96AM
Teaching tip type 250 µL
Check head type on initialize  selected

a   b                                                                                                     c
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c Click OK.
10 In the Miscellaneous area, verify the property settings. The following figure shows 

the settings for each profile.
11 If you have made any changes, click Update this profile.

Figure Miscellaneous area of the Profiles tab showing variations in property settings for different AssayMAP 
profiles
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About verifying the deck configuration in the profile

• Autofill Station at deck location 1. Controls pumping the liquid to and from the wash 
station. This configuration is required for all AssayMAP applications and included 
in all AssayMAP profiles by default. 

• Heating Shaking Station at deck location 4. Controls the Peltier Thermal Station 
(also known as the CPAC Ultraflat).
Note: The Heating Shaking Station configuration is required for any heating or 
shaking accessory that is controlled by an STC or MTC controller.

• Orbital Shaking Station at deck location 9. Controls the Orbital Shaking Station.
The following table describes the requirements for each profile.

Profile Verification tasks See...

AssayMAP 1 profile By default, the AssayMAP 1 profile includes 
only the Autofill Station (wash station) as an 
accessory configuration. 
All other deck locations are configured as 
standard platepads.

IMPORTANT If the Peltier Thermal Station 
and Orbital Shaking Station are installed on the 
AssayMAP Bravo deck, you configure the 
corresponding deck locations for these 
accessories in the AssayMAP 1 profile.

“Verifying the Autofill Station 
configuration (wash station)” on 
page 49

GlykoPrep-Plus profile By default, the GlykoPrep-Plus profile includes 
the following configurations:
• Autofill Station (wash station)
• Heating Shaking Station for the Peltier 

Thermal Station (location 4)
• Orbital Shaking Station (location 9)

IMPORTANT If these accessories are not 
installed on the AssayMAP Bravo deck, you 
configure the corresponding deck locations for 
a standard platepad.

• “Verifying the Autofill Station 
configuration (wash station)” 
on page 49

• “Verifying the Peltier Thermal 
Station configuration” on 
page 51

• “Verifying the Orbital Shaking 
Station configuration” on 
page 53

AssayMAP Peptide 
Sample Prep profile

By default, the AssayMAP Peptide Sample Prep 
profile includes the following configurations:
• Autofill Station (wash station)
• Heating Shaking Station for the Peltier 

Thermal Station (location 4)
• Orbital Shaking Station (location 9)

IMPORTANT If these accessories are not 
installed on the AssayMAP Bravo deck, you 
configure the corresponding deck locations for 
a standard platepad.

• “Verifying the Autofill Station 
configuration (wash station)” 
on page 49

• “Verifying the Peltier Thermal 
Station configuration” on 
page 51

• “Verifying the Orbital Shaking 
Station configuration” on 
page 53



3   Setting up the computer and software
About verifying the deck configuration in the profile

48  AssayMAP Bravo Platform Installation Guide

Single Plate InSolution 
Digestion profile

By default, the Single Plate InSolution Digestion 
profile includes the following configurations:
• Autofill Station (wash station)
• Heating Shaking Station for the Peltier 

Thermal Station (location 4)
• Orbital Shaking Station (location 9)

IMPORTANT If these accessories are not 
installed on the AssayMAP Bravo deck, you 
configure the corresponding deck locations for 
a standard platepad.

In addition to the physical accessories, this 
profile includes a Lid Hotel configuration at 
deck locations 3 and 7. Even though standard 
platepads are installed at these deck locations, 
the Lid Hotel configuration enables the 
locations for Delidding and Relidding tasks.

• “Verifying the Autofill Station 
configuration (wash station)” 
on page 49

• “Verifying the Peltier Thermal 
Station configuration” on 
page 51

• “Verifying the Orbital Shaking 
Station configuration” on 
page 53

AssayMAP 
Normalization profile

By default, the AssayMAP Normalization profile 
includes the following configurations:
• Autofill Station (wash station)
• Heating Shaking Station for the Peltier 

Thermal Station (location 4)

IMPORTANT If Peltier Thermal Station is not 
installed on the AssayMAP Bravo deck, you 
configure the corresponding deck location for a 
standard platepad.

The AssayMAP Normalization profile also 
includes accessory teachpoints at deck 
locations 2 and 6 for the Bravo Plate Riser 
accessory, which must be verified and adjusted 
if necessary. The Bravo Plate Riser has no 
configuration settings.

• “Verifying the Autofill Station 
configuration (wash station)” 
on page 49

• “Verifying the Peltier Thermal 
Station configuration” on 
page 51

Profile Verification tasks See...
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Verifying the Autofill Station configuration (wash station)

IMPORTANT
Use the following procedure to verify the Autofill Station configuration settings in every 
AssayMAP profile.

All the supplied profiles already include the Autofill Station configuration. You perform 
the following steps to ensure that the setup is correct. 

Verifying the Autofill Station configuration in a profile

To verify the Autofill Station configuration in a profile
1 In Bravo Diagnostics, ensure the correct profile is selected in the Profiles tab.
2 In the Configuration tab, verify that the deck image shows a Pump Module at deck 

location 1.
Note: The AssayMAP 1 profile has no other accessories configured by default, 
but you will be adding those accessories in a subsequent procedure. The other 
profiles have accessories at deck locations 4 and 9, by default.

3 To verify the settings, right-click deck location 1 in the image. In the shortcut menu 
that appears, click Configure location > Accessory. The Bravo Accessories Wizard 
opens.

4 In the Location for accessory list, verify the location and then click Next. 
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5 In the Accessory already configured page, click Yes, reconfigure existing accessory, 
and then click Next. 

6 Verify the following property settings in the Autofill Station properties table, and then 
click Next.

7 Click Finish. The Bravo Accessories Wizard closes.
8 If you made any changes to the configuration settings, click the Profiles tab, and 

then click Update this profile to save the changes.
 

Autofill station properties Setting
Fill module 1
Pump for filling Pump 1
Direction for filling Forward
Empty module 1
Pump for emptying Pump 2
Direction for emptying Reverse
Use Weigh Station? No
Weigh Station module number 1
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Verifying the Peltier Thermal Station configuration

IMPORTANT
If the Peltier Thermal Station is installed in the AssayMAP Bravo Platform, use the 
following procedures to configure and test the accessory in every profile.

Verifying the Peltier Thermal Station configuration in a profile

To verify the Peltier Thermal Station configuration in a profile:
1 In Bravo Diagnostics, ensure the correct profile is selected in the Profiles tab.
2 In the Configuration tab, verify that the deck image shows a Heating Shaking 

Station icon at deck location 4.

3 To verify the settings, right-click deck location 4 in the image. In the shortcut menu 
that appears, click Configure location > Accessory. The Bravo Accessories Wizard 
opens.

4 In the Location for accessory list, verify that location 4 is selected, and then click 
Next. 
• If the Choose Accessory page appears, select the Heating Shaking Station, and 

then click Next. 
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• If the Accessory already configured page appears, click Yes, reconfigure existing 
accessory, and then click Next. 

5 Verify the following settings in the Properties table, and then click Next.

Note: The Inheco STC Controller ships with an MTCSTC Id setting of 0. However, 
this setting may have been changed on demo units for use with multiple 
devices. Use the DIP switches on the back of the STC Controller to determine 
what the actual Id setting is and make changes if necessary. See the 
manufacturer’s user documentation for more information.

6 Click Finish. The Bravo Accessories Wizard closes.
7 When the accessory configuration message appears, click Yes to move the 

teachpoint to a safe height.
8 If you made any changes to the configuration settings, click the Profiles tab, and 

then click Update this profile to save the changes.
 

Properties Setting
MTCSTC Id 0
Type STC
Slot Id 1
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Verifying the Orbital Shaking Station configuration

IMPORTANT
If the Orbital Shaking Station is installed in the AssayMAP Bravo Platform, use the 
following procedures to configure and test the accessory in every profile.

Verifying the Orbital Shaking Station configuration in a profile

To verify the Orbital Shaking Station configuration in a profile:
1 In Bravo Diagnostics, ensure the correct profile is selected in the Profiles tab.
2 In the Configuration tab, verify that the deck image shows a Orbital Shaking Station 

icon at deck location 9.

3 To verify the settings, right-click deck location 9 in the image. In the shortcut menu 
that appears, click Configure location > Accessory. The Bravo Accessories Wizard 
opens.

4 In the Location for accessory list, verify that the location is 9, and then click Next.
5 In the Accessory already configured page, click Yes, reconfigure existing accessory, 

and then click Next. 
• If the Choose Accessory page appears, select the Heating Shaking Station, and 

then click Next. 
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• If the Accessory already configured page appears, click Yes, reconfigure existing 
accessory, and then click Next. 

6 In the Properties table, verify the Serial Port number and Module Number, and then 
click Next.

*The Serial Port parameter will be automatically defined when a USB-to-serial 
adapter is connected to the computer. You might need to lookup the port assigned 
to this device in the Windows Device Manager. 
Note: Occasionally, a port number is reassigned for a USB-to-serial connection if 
you disconnect and reconnect the accessory. If this happens, you must verify 
that the correct Serial Port is set in each profile.

7 Click Finish. The Bravo Accessories Wizard closes.
8 If the accessory configuration message appears, click Yes to move the teachpoint 

to a safe height.
9 If you made any changes to the configuration settings, click the Profiles tab, and 

then click Update this profile to save the changes.
 

 Property Setting
Serial Port 1*
Module Number 1
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Initializing the profile that you are verifying

Initializing the profile establishes communication with the AssayMAP Bravo Platform 
and accessories. You will initialize a profile to test the accessory settings and verify the 
gripper adjustment for that profile. 

Before you start

WARNING
When you initialize the Bravo Platform, the head and tie bar can move. To prevent 
potential injury, keep clear of the device while it is in motion.

Initializing the profile in Bravo Diagnostics

To initialize the profile:
1 In the Profiles tab, ensure that the correct profile is selected, and then click Initialize 

this profile to start initializing the selected profile.

2 If the There appears to be a plate present error message appears, click Ignore and 
Continue to continue the homing process. 

3 When the verify that it is safe to home the W-axis message appears, click Retry to 
continue homing the w-axis.
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Testing the accessories

Before you start

Ensure that you have verified the accessory configuration in the given profile before you 
perform the following workflow.

                                                        

Step Task See …

1 Initialize the AssayMAP 1 profile. “Initializing the profile in Bravo 
Diagnostics” on page 55

2 Test the communication with the 
accessories.

Procedures in this topic

3 Initialize the next profile. “Initializing the profile in Bravo 
Diagnostics” on page 55

4 Test the communication with the 
accessories.

Procedures in this topic

5 Repeat steps 3 and 4 for each of the 
remaining profiles.

—
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Testing the Pump Module

Use the following procedure to test the communication with the Pump Module. In a 
subsequent verification procedure, you will run the Startup utility, which will test the 
functioning of the Pump Module and wash station using liquid. 

To test the communication with the Pump Module:
1 Ensure that the Pump Module is on.
2 Lift the flip-top cover on each pump head so that it is fully open. 

Note: While the pump heads are open, no liquid will pump in the subsequent 
steps. 

                                                        

00306
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3 In the Configuration tab, click the Autofill Station icon, and then click Diagnose 
accessory. The Bravo Accessory Diagnostics dialog box opens.

4 Click Run pumps.
5 Verify that the pumps run. While they are running, verify that the pumps are 

spinning in the correct directions:
• Top pump should be spinning clockwise.
• Bottom pump should be spinning counter-clockwise. 

6 Click Stop pumps, and then click OK.
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Testing the Peltier Thermal Station 

To test the Peltier Thermal Station:
1 Ensure that the MTC Controller is on.
2 In the Accessory Configuration area, click the Heating Shaking Station icon for deck 

location 4, and then click Diagnose accessory. The Bravo Accessory Diagnostics 
dialog box opens.

3 In the Bravo Accessory Diagnostics dialog box, verify that the correct device (CPAC 
Ultraflat) appears in the display at the top. 

4 In the Heat area, set the parameters to test the temperature function:
a In the Target temp box, type the temperature (°C). 

For example, set the CPAC at deck location 4 to 45 °C.
b Click Start. 
c At the Peltier Thermal Station on the deck, verify that the accessory operates 

correctly. 
You can also monitor the readout in the Current temperature display. 

d Click Turn Off to stop the heating or cooling, and click OK to close the dialog 
box.
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Testing the Orbital Shaking Station

To test the Orbital Shaking Station:
1 In the Accessory Configuration area, click the Orbital Shaking Station icon, and then 

click Diagnose accessory. The Bravo Accessory Diagnostics dialog box opens.

2 Type the RPM, select the Stir direction, and then click Start. 
3 At the Orbital Shaking Station on the deck, verify that the accessory operates 

correctly.
4 In the Bravo Accessory Diagnostics dialog box, click Stop, and then click OK.
 

IMPORTANT
Ensure that you verify the profile settings and test the accessories in each of the other 
profiles before you set the teachpoints.
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• “Teaching part 1: Setting teachpoints in AssayMAP 1 profile” on page 62
• “Teaching part 2: Adjusting teachpoints for accessories” on page 67
• “Teaching part 3: Updating other profiles based on AssayMAP 1” on page 73
• “Checking and adjusting the gripper offset” on page 77
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Teaching part 1: Setting teachpoints in AssayMAP 1 profile

About this topic

This topic describes how to set the teachpoints in the AssayMAP 1 profile. After you set 
the teachpoints in this profile, you will run a teachpoint-update protocol to automate the 
teachpoint adjustments for all the other profiles in the Protein Sample Prep Workbench.
Alternatively, you can follow a manual workflow to set the teachpoints for all nine deck 
locations in every device profile in the Protein Sample Prep Workbench. For details, see 
“Workflow for setting teachpoints in each profile manually” on page 106.

Teachpoint requirements

A teachpoint is a set of axial coordinates that define a location to which the Bravo head 
moves. Each of the nine deck locations has a teachpoint. 

CAUTION
Using a profile that is associated with teachpoints from a different instrument can 
result in a hardware collision and cause equipment damage. Ensure that you verify 
the teachpoints associated with each profile for your specific instrument and Bravo 
96AM Head.

IMPORTANT
Every device profile in the Protein Sample Prep Workbench must be adjusted to the 
correct teachpoints for the specific AssayMAP Bravo Platform that you are installing.

Before you start

WARNING
To avoid potential injury and damage to the device, only personnel trained in how to 
teach the Bravo Platform should perform the procedures in this topic.

WARNING
The red Stop motors button in Bravo Diagnostics does not perform an immediate 
stop. The Bravo head can continue to move in the same direction at the same speed 
after you click the button. To perform an emergency stop, press the red button on the 
emergency-stop pendant.

CAUTION
To prevent the head from crashing into an accessory, be sure to start the accessory 
teaching process from the safe z-axis point above the accessory location. This is 
especially important if you use the Set all teachpoints based upon selected 
teachpoint feature.

IMPORTANT
Make sure that you remove all labware from the deck except for the wash station at 
deck location 1. The wash station remains installed at deck location 1 in the following 
procedure while you set the teachpoint for deck location 2. In a subsequent procedure, 
you will adjust the wash station teachpoint at deck location 1. 

Ensure that you have the required resources:
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• 250-µL pipette tip

IMPORTANT
Ensure that the pipette tip is new and in good condition.

• 0.010-inch (0.254 mm) feeler gauge
This gauge is used to set the vertical distance between the pipette tip and top of 
the crosshairs mark on the platepad or accessory.

The following procedures assume that you have basic knowledge of the Bravo 
teaching process and have been trained to teach the Bravo Platform.  

CAUTION
To prevent potential equipment damage, ensure that the deck is clear of any 
obstacles before initializing the AssayMAP Bravo Platform.

 

Ensure the following:
• All Workbench profiles have been configured correctly. See “Verifying the profile 

settings and configuration” on page 43.
• The Protein Sample Prep Workbench software is not open. 
• In the VWorks software, Simulation is off. 

T

Workflow for setting the teachpoints
Step For this task... See...

1 In the Bravo Diagnostics dialog 
box, initialize the AssayMAP 1 
profile. 

“Initializing the profile that you are 
verifying” on page 55

2 Set the teachpoint for deck 
location 2 and derive the 
remaining teachpoints for the 
AssayMAP 1 profile.

“Setting the teachpoint for deck 
location 2 and deriving the remaining 
teachpoints” on page 64

3 Adjust the accessory location 
teachpoints for the AssayMAP 1 
profile.

“Teaching part 2: Adjusting 
teachpoints for accessories” on 
page 67

4 Use the AssayMAP Update 
Teachpoints protocol to update 
the remaining profiles.

“Teaching part 3: Updating other 
profiles based on AssayMAP 1” on 
page 73
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Setting the teachpoint for deck location 2 and deriving the remaining teachpoints

To set the teachpoints:
1 Manually seat a 250-µL pipette tip on probe A1 (back left corner of the Bravo 96AM 

Head). Ensure that the pipette tip locks into place with the probe. 
Ensure a standard platepad is installed at deck location 2.

2 In the Bravo Diagnostics dialog box, click the Jog/Teach tab. 

3 In the image of the Bravo deck in the upper left corner, click Location 2.
4 Carefully, use the Jog Axes controls to adjust the position of the pipette tip above 

the crosshairs on platepad 2. Use incrementally smaller jog increments as you jog 
the pipette tip down closer to the crosshairs.
As the pipette tip moves down along the z-axis towards the crosshairs, the 
following error message appears. Visually inspect the clearance remaining 
between the tip and the crosshairs. If the tip is not yet at the crosshairs, adjust the 
jog increment as required, and click Ignore to continue jogging the head down.

CAUTION
Before you click Ignore in the error message, verify that enough space remains to 
continue jogging the head down. Jogging the head down too far will result in a 
collision and cause equipment damage.
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Note: This error message appears every time you jog in the z-axis to a point that 
is lower than the default z-axis teachpoint (60.00 mm). 

5 When the pipette tip is 1–2 mm above the crosshairs, do the following:
a Verify that the A1 pipette tip is perfectly centered above the platepad 

crosshairs in the x- and y-axes.
b Set the Jog Axes Up/Down increment to 0.2-mm. Carefully, jog the head down 

in 0.2-mm increments just until the feeler gauge cannot fit under the pipette 
tip.

c Raise the head by 0.05-mm increments until you reach the lowest possible 
height that allows the 0.010-inch feeler gauge to slide under the pipette tip 
without deflecting it. 

6 Click Teach.
7 To derive the teachpoints for the remaining locations from deck location 2:

a In the Advanced operations list, select Set all teachpoints based upon the 
selected teachpoint. 

b Ensure that deck location 2 is still selected, and then click the Perform 
advanced operations. 

c Click OK in the confirmation message.

Fine tuning the teachpoints

To fine tune the automatically derived teachpoints:
1 In the Jog/Teach tab image of the Bravo deck, click Location 3.
2 In the Approach height above teachpoint list, select 10, and then click Approach.

The Bravo head moves to deck location 3 and moves down so that the pipette tip is 
approximately 10 mm above the platepad crosshairs. 

3 Carefully, use the Jog Axes controls to adjust the position of the A1 pipette tip 
above the crosshairs. Use incrementally smaller jog increments as you jog the tip 
down closer to the crosshairs.

4 When the pipette tip is 1–2 mm above the crosshairs, do the following:
a Verify that the A1 pipette tip is perfectly centered above the crosshairs in the x- 

and y-axes.
b Set the Jog Axes Up/Down increment to 0.2-mm. Carefully, jog the head down 

in 0.2-mm increments just until the feeler gauge cannot fit under the pipette 
tip.

c Raise the head by 0.05-mm increments until you reach the lowest possible 
height that allows the 0.010-inch feeler gauge to slide under the pipette tip 
without deflecting it. 
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5 Click Teach.
6 Repeat steps 1 to 5 for deck locations 4, 5, 6, 7, and 8. 

IMPORTANT
If the Peltier Thermal Station is installed at deck location 4, ensure that the plate nest is 
empty and the PCR plate insert is not installed. 

7 Adjust the teachpoints for the accessory locations. See “Teaching part 2: Adjusting 
teachpoints for accessories” on page 67.
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Teaching part 2: Adjusting teachpoints for accessories

This topic includes the following procedures:
• “Teaching the Orbital Shaking Station at deck location 9” on page 67
• “Teaching the 96AM Wash Station at deck location 1” on page 68
• “Adjusting the teachpoint at deck location 2 for the Cartridge & Tip Seating Station” 

on page 71

Teaching the Orbital Shaking Station at deck location 9

If the Orbital Shaking Station is installed at deck location 9, a teachpoint adjustment is 
required. Use the following procedure to set the teachpoint for the Orbital Shaking 
Station at deck location 9. 

Before you start
Ensure that you have the following:
• Pipettor teaching plate (G5550-17692). The teaching plate is a 10-mm thick metal 

plate that fits in the plate nest of an accessory. The teaching plate has a crosshairs 
in one corner, as the following figure shows.

Figure Pipettor teaching plate

• 250-µL pipette tip seated on probe A1 (back left corner) of the Bravo 96AM Head.

IMPORTANT
Ensure that the pipette tip is new and in good condition.

• 0.010-inch (0.254 mm) feeler gauge
This gauge is used to set the vertical distance between the pipette tip and top flat 
surface of the Orbital Shaking Station.

To teach the Orbital Shaking Station at deck location 9:
1 Place the teaching plate in the plate nest of the Orbital Shaking Station. Ensure that 

the crosshairs is at the back left corner and facing upward. 
Press down on the teaching plate so that the bottom touches the top surface of the 
plate nest. 

2 In the Jog/Teach tab, and click Location 9.
3 In the Approach height above teachpoint box, type 15, and then click Approach.

The Bravo head moves to deck location 9 and moves down so that the pipette tip is 
approximately 5 mm above the crosshairs on the 10-mm teaching plate. 
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4 Carefully, use the Jog Axes Down +Z control to move the pipette tips down until the 
pipette tip is 1–2 mm from the crosshairs, and then use the Jog Axes X/Y controls 
to center the A1 tip above the crosshairs.

5 When the A1 tip is perfectly centered above the crosshairs, click Teach to save this 
value temporarily.

6 Click the Move to safe height at current X/Y position. Remove the teaching plate from 
the Orbital Shaking Station. 

7 Ensure that deck location 9 is still selected, and then click Move. The head moves 
down so that the tip is approximately 10 mm above the top surface of the plate 
nest in the Orbital Shaking Station. 

8 Use the Down +Z control to lower the pipette head incrementally.
9 When the pipette tip is 1–2 mm above the flat surface of the Orbital Shaking 

Station, do the following:
a Set the Down +Z increment to 0.2 mm. Carefully, jog the head down in 0.2-mm 

increments just until a 0.254-mm (0.010-inch) feeler gauge cannot fit under the 
pipette tip.

b Raise the head by 0.05-mm increments until you reach the lowest possible 
height that allows the feeler gauge to slide under the pipette tip without 
deflecting it. 

Note: Alternatively, you may use the Jog Axes controls to move the head down in 
the z-axis until the pipette tip is as close as possible to the top surface of the 
plate nest, without making contact. 

10 Click Teach to set the new teachpoint values for deck location 9.
11 To save the new teachpoint for this location, click the Profiles tab, and then click 

Update this profile.
 

Teaching the 96AM Wash Station at deck location 1

CAUTION
Failure to remove the pipette tip from the A1 probe will cause the pipette tip to collide 
with the wash station chimney, damaging the Bravo 96AM Head and 96AM Wash 
Station. Ensure that you remove the pipette tip before starting the procedure.

For this procedure, you will center the syringe probes above the wash station chimneys 
to adjust the x- and y-axes for the teachpoint, but you will use the existing z-axis 
teachpoint.

To teach the 96AM Wash Station:
1 If you have not already done so, remove the pipette tip from probe A1. 

IMPORTANT
Ensure that the 250-µL tip remains selected as the Teaching tip type in the Profiles tab. 
Ensure that no pipette tips or cartridges are seated on the Bravo 96AM Head.

2 In the Bravo Diagnostics Jog/Teach tab, click Location 1. 
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Note: Additional accessories will appear in the image if you have configured 
them in this profile. 

3 In the Location list, locate the Z-axis box. Write down the Z-axis value on a piece of 
paper. You will use this value in a subsequent step.
Note: The Z-axis teachpoint value for deck location 1 is typically between 
105.2–105.8 mm for a standard height AssayMAP Bravo Platform and standard 
platepad.

4 In the Approach height above teachpoint box, type 50, and then click Approach.
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5 Carefully, use the Jog Axes controls to position the syringe probes so that they are 
perfectly centered over the corresponding chimneys in the wash station.
The tips of the probes should be approximately 1 mm above the tops of the 
chimneys. 

6 When the probes and chimneys are perfectly aligned, use the Jog Axes controls to 
move the head down slowly along the z-axis to the original Z-axis teachpoint value 
that you recorded in step 3.
Note: This step will insert the probes into the wash station chimneys, which is a 
normal part of the teaching process.

7 When the position of the z-axis (as indicated by the Z-axis readout in the bottom 
right of the screen) matches the value that was written down from above, click 
Teach to set the new teachpoint for deck location 1. 
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8 Click the Move to safe height at current X/Y position to remove the probes from the 
wash station chimneys, and return the head to the safe Z-height. 

9 In the Profiles tab, click the Update this profile to save the new teachpoints. 
 

Adjusting the teachpoint at deck location 2 for the Cartridge & Tip Seating Station 

You adjust the teachpoint for deck location 2 to enhance the precision of the probes as 
they move into the cartridges or pipette tips in the Cartridge & Tip Seating Station.

IMPORTANT
Ensure that no pipette tips or cartridges are seated on the Bravo 96AM Head. Ensure 
that the 250-µL tip remains selected as the Teaching tip type in the Profiles tab. 

To adjust the teachpoint for the Cartridge & Tip Seating Station:
1 Ensure that no labware is on the deck other than the wash station at deck 

location 1.
2 In the Bravo Diagnostics Jog/Teach tab, click Location 2. 
3 Write down the value that appears in the Z-axis box for location 2. You will use this 

value in a later step.

Note: Additional accessories will appear in the image if you have configured 
them in this profile. 

4 In the Approach height above teachpoint (mm) list, select 50, and then click 
Approach.

5 Using care to avoid touching the head probes, place the Cartridge & Tip Seating 
Station on the platepad at deck location 2. Ensure that the station is fully seated on 
the platepad.
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6 Carefully, use the Jog Axes controls to jog the head down incrementally to the 
Cartridge & Tip Seating Station.

7 When the syringe probes are just above the wells, use the Jog Axes controls for the 
x- and y-axes to position the probes so that they are perfectly centered within the 
openings of the corresponding wells in the Cartridge & Tip Seating Station.

8 When the probes are perfectly centered within the well openings:
a Click Teach to save these values temporarily. 
b Click Move to safe height at current X/Y position to return the head to a safe z-

axis height. 
9 Remove the Cartridge & Tip Seating Station from the deck.
10 Carefully, use the Down +Z control to jog the head down incrementally until the 

value in the Z-axis box matches the value that you noted in step 3.
11 Click Teach to set the new teachpoint.
12 In the Profiles tab, click Update this profile.
 

00240
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Plate Orientation

1 2 3
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Teaching part 3: Updating other profiles based on AssayMAP 1

The AssayMAP Teachpoint Update protocol will guide you through the process of 
setting teachpoints for all other profiles in the Protein Sample Prep Workbench based 
on the AssayMAP 1 profile.
Several of the profiles included in the Protein Sample Prep Workbench require special 
teachpoint adjustments for accessories that will be placed on specific Bravo deck 
locations, which are listed in the following table. The AssayMAP Teachpoint Update 
protocol automatically makes these teachpoint adjustments.

Table Special adjustments automatically performed by Teachpoint Update protocol

 

Before you start

Ensure that you have completed the following procedures:
• “Teaching part 1: Setting teachpoints in AssayMAP 1 profile” on page 62.
• “Teaching part 2: Adjusting teachpoints for accessories” on page 67
Ensure that you have the required resources:
• AssayMAP Teachpoint Update protocol (.pro) installed in the following location:

C:\VWorks Workspace\Workbench\Protocols\AssayMAP Teachpoint Update 
v1p0.pro

• 250-µL pipette tip

IMPORTANT
Ensure that the pipette tip is new and in good condition.

Profile Deck 
location

Teachpoint adjustments for accessories

GlykoPrep-Plus 4 Raises the teachpoint z-axis coordinate by 
4.4 mm to accommodate the height of the Red 
PCR Insert on the Peltier Thermal Station.

AssayMAP 
Normalization

2, 6 Raises the teachpoint z-axis coordinate by 
28.5 mm at these deck locations to 
accommodate the height of the Bravo Plate 
Riser.
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Note: The AssayMAP Teachpoint Update protocol is not designed to work in 
simulation mode.

Starting the AssayMAP Teachpoint Update protocol

To start the AssayMAP Teachpoint Update protocol:
1 In the VWorks window, click File > Open. The Open dialog box appears.
2 In the Open dialog box, ensure the file type is Protocol Files (*.pro). Locate the 

C:\VWorks Workspace\Workbench\Protocols folder, select the AssayMAP 
Teachpoint Update v1p0.pro file, and then click Open.

3 When the following VWorks initialization message appears, click Yes. 

The AssayMAP Bravo.dev file opens, and the AssayMAP 1 profile initializes.
4 Ensure that the AssayMAP Teachpoint Update protocol is open in the VWorks 

window, and then click Start.
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5 In the Run Configuration dialog box, click Finish to start the protocol.

6 When the Update Teachpoints dialog box appears, click Continue update 
teachpoints in all the other workbench profiles based on the AssayMAP 1 profile.
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7 When the WARNING dialog box appears, click Continue to update the teachpoints in 
all the Workbench profiles based on the AssayMAP 1 profile teachpoints.

IMPORTANT
After the protocol completes the update process, make sure that you verify the setup. 
See “Verification workflow” on page 84.
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Checking and adjusting the gripper offset

To pick up and place labware correctly, the gripper fingers must be positioned at equal 
distances from the long sides of the labware on a platepad. 

IMPORTANT
Use the procedures in this section to adjust the gripper y-axis offset and test the 
gripper performance in every profile.

Before you start

IMPORTANT
Before you adjust the gripper y-axis offset, ensure that the pipettor teachpoints (x-, y-, 
and z-axes) have been verified and no pipette tips or cartridges are installed on the 
head.

Make sure that:
• The Bravo gripper fingers are in good condition and aligned with the head. Perform 

a visual inspection to ensure the gripper fingers are not bent.
• The gripper pads (black rubber) are in place on the gripper fingers and in good 

condition. Ensure the gripper pads are not partially ripped off or pulled askew.
Use the following workflow:

                                                        

Step Task See …

1 Initialize the AssayMAP 1 profile. “Initializing the profile that you are 
verifying” on page 55

2 Adjust the gripper y-axis offset, and 
then write down the Y offset value.

“Adjusting the gripper y-axis offset” 
on page 78

3 Test the gripper pick-and-place 
operations.

“Testing the gripper pick-and-place 
operations” on page 81

4 Initialize the next profile. “Initializing the profile that you are 
verifying” on page 55

5 Adjust the gripper y-axis offset using 
the Y offset value that you noted in 
step 2. 

“Adjusting the gripper y-axis offset” 
on page 78

6 Test the gripper pick-and-place 
operations.

“Testing the gripper pick-and-place 
operations” on page 81

7 Repeat steps 4–6 for each of the 
remaining profiles.

—
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Adjusting the gripper y-axis offset

Use deck location 8 (front center) for the following procedure.

IMPORTANT
Ensure that you use a standard platepad for the following procedure.

To adjust the gripper y-axis offset:
1 In Bravo Diagnostics, click the Gripper tab.
2 In the Labware list, select None.
3 In the deck image, click a deck location where a standard platepad is installed. The 

location should be easily accessible, for example in the front row or a corner.

4 Click Move to move the gripper to the previously saved teachpoint for the selected 
location. 
The Bravo head moves above the deck location, and the gripper assembly extends 
down (Zg-axis) so that the gripper fingers are just above the top surface of the 
platepad.
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5 Visually inspect the spacing between the black rubber gripper pads and the sides 
of the platepad (y-axis). Make sure that all the gripper pads have clearance so that 
the gripper can move down without colliding with the platepad. 

Figure Gripper pad clearance from sides of platepad (top view)

6 If the gripper pads are touching or overlapping on one side of the platepad, do the 
following to adjust the clearance:
a Click the Jog/Teach tab, and ensure that the deck location you selected in 

step 3 is still selected.
b Under Jog/Axes, set the Back -Y/Forward +Y increment to a small enough size, 

such as 0.2 mm.

CAUTION
Make sure you use small enough jog increments to prevent any gripper collisions, 
which could damage the gripper.

Bravo

-Zg

+Y

-Y

+Zg
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c Click Back -Y or Forward +Y as required to adjust the gripper y-axis position so 
that the gripper pads will clear the sides of the platepad when you jog down in 
the next step.
When the following message appears, click OK.

7 After ensuring that the gripper pads will not collide with the platepad, set the Down 
+Z increment to 5.0 mm, and then click Down +Z. 

CAUTION
Make sure you do not jog the gripper down more than 5.0 mm at this stage. Jogging 
down farther will result in a gripper collision with the setscrew on the platepad, which 
could damage the gripper.

When the following message appears, click OK.

At this stage, the gripper fingers should be next to the sides of the platepad.
8 Fine tune the gripper alignment as follows:

a In the Gripper tab, set the Close +G increment to a small value, such as 0.2 mm, 
and then click Close +G so that you can clearly see the alignment of the gripper 
pads with the platepad.
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IMPORTANT
Do not click Close gripper. Otherwise, you must redo the procedure.

b In the Jog/Teach tab, set the y-axis increment to 0.2 mm, and then use the 
Back -Y and Forward +Y buttons to position the gripper so that the fingers are at 
equal distances around the platepad. 
Ensure the pair of gripper pads on each side are as close as possible to the 
sides of the platepad without actually touching the platepad.
Note: If a gripper finger is not perfectly straight, one of its gripper pads may 
be closer than the other to the side of the platepad, as the following figure 
shows. In this case, adjust the y-axis using the gripper pad closest to the 
platepad and the diagonally opposite gripper pad for reference.

Figure Example of diagonally opposite gripper pads (top view)

9 In the Gripper tab, click Teach Y offset for gripper.
10 In the Profiles tab, click Update this profile.
 

Note: Write down the Y offset value. You can use this same value to update the 
remaining profiles.

Testing the gripper pick-and-place operations

For this procedure, you will use the gripper to move a labware between deck 
locations 7 and 8. 
Ensure that you have a microplate for this test, for example: 
96 Greiner 650201, U-Bottom Standard, PolyPro
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To test the gripper pick-and-place operations:
1 Place a microplate on a platepad at the deck location where you are starting the 

test.
2 In Bravo Diagnostics, click the Gripper tab. 
3 In the Labware list, select the name of the labware type you are using.
4 Select the location for the move:

a In the Location A list, select the current deck location of the labware. 
b In the Location B list, select the deck location to which the labware will move.

5 Set the Speed to Slow.
6 Click Pick A -> B to pick up the microplate from deck location A and place it on deck 

location B. Click Pick B -> A to pick up the microplate from deck location B and place 
it on deck location A.

7 Repeat steps 4 and 6 for the remaining deck locations where the gripper will be 
transferring labware.

8 Set the Speed to Fast, and repeat steps 4, 6, and 7.
9 Make sure that the gripper holds the microplate securely and keeps it level while 

moving the microplate from location to location. 
 

If the gripper performs the operation without problem, no further adjustment is 
required.
If the gripper has problems performing the operations, the solution to the problems 
depends on the cause. Carefully inspect the gripper finger alignment and the 
condition of the gripper pads. Ensure that the labware definition is correct for the 
selected labware. See the Bravo Platform User Guide or the Bravo Platform Service 
Guide for details.
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• “Verification workflow” on page 84
• “About installing the Bravo pendant, Light Curtain, and shields” on page 84
• “Opening the Workbench and accessing the utilities” on page 86
• “Running the Startup utility” on page 87
• “Testing the safety equipment” on page 89
• “Washing the syringes to prepare for first time use” on page 91
• “Performing a test run” on page 93
• “Running the Syringe Test utility” on page 103
• “Running the Shutdown utility” on page 104
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Verification workflow

After the AssayMAP Bravo Platform is set up in the VWorks software, perform the 
following steps in the order given to verify the installation and setup.

About installing the Bravo pendant, Light Curtain, and shields

WARNING
Moving-parts hazards are accessible through the front, rear, and side openings of the 
Bravo Platform. To prevent potential injury, ensure that the safety equipment is 
installed and in good working condition.

Ensure that the following are installed properly. For instructions, see the Bravo Platform 
Safety and Installation Guide.
• Emergency-stop pendant. Ensure that the pendant and its cable are in good 

condition and connected to the Pendant port on the junction box.
• Light Curtain. Ensure the lightpost transmitter (TX) and receiver (RX) cables are 

connected and that the light beams are aligned correctly.
• Bravo front, side and rear shields. Ensure that the accessory tubing and cabling is 

routed off the Bravo deck through the access windows in the side and rear shields.

Step For this task... See...

1 Ensure that the Light Curtain, 
pendant, and shields are 
installed.

“About installing the Bravo pendant, 
Light Curtain, and shields” on page 84

2 Open the Protein Sample Prep 
Workbench and access the Utility 
Library.

“Opening the Workbench and 
accessing the utilities” on page 86

3 Run the Startup utility. “Running the Startup utility” on 
page 87 

4 Test the safety equipment. “Testing the safety equipment” on 
page 89

5 Run the Syringe Wash utility for 
60 cycles.

“Washing the syringes to prepare for 
first time use” on page 91

6 Perform a test run of the Affinity 
Purification protocol.

“Performing a test run” on page 93

7 Run the Syringe Test utility. “Running the Syringe Test utility” on 
page 103

8 Run the Shutdown utility. “Running the Shutdown utility” on 
page 104
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Figure AssayMAP Bravo Platform with Light Curtain and emergency-stop pendant

Figure Bravo rear shield with access window covers installed
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Opening the Workbench and accessing the utilities

Opening the Protein Sample Prep Workbench

To open the Protein Sample Prep Workbench:
On the Windows desktop, double-click the Protein Sample Prep Workbench icon.

Alternatively, on the Windows desktop, click Start  > Agilent Technologies > Protein 
Sample Prep Workbench.

Accessing a workbench utility

To access a utility:
1 In the Protein Sample Prep Workbench, do one of the following:

• If you have not yet logged in, click Utility Library. The VWorks software starts, 
and then the User Authentication dialog box opens.

Type your VWorks user name and password, and then click OK. 
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Note: The default login user name is administrator.  
The default password is administrator.

• If you have already logged in to the software, click the Utility Library button in 
any of the other libraries of the Protein Sample Prep Workbench.

2 In the Utility Library, locate the name of the utility you want to use, and then click 
Utility to open the utility.

Figure Utility Library in the Protein Sample Prep Workbench

3 Click Instructions to display the user guide for the corresponding utility.
 

Running the Startup utility

WARNING
If you touch any of the moving parts or attempt to move labware while the Bravo 
Platform is in operation, the device could pinch, pierce, or bruise you. Keep your 
fingers, hair, clothing, and jewelry away from the device while it is in motion. 

The Startup utility initializes the AssayMAP Bravo Platform and primes the wash lines 
from the Pump Module.
To run the Startup utility:

1 Open the Utility Library, locate the System Startup/Shutdown utility, and then click 
Utility.
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2 Click Instructions.
3 Follow the instructions to run the Startup utility.

Use the following settings to provide plenty of time to prime the lines and observe 
the flow through the wash station chimneys:

4 During the priming step, ensure that fluid flows out of the top of each chimney. 
Check for any damaged chimneys in the wash station.
Click Continue to complete the Startup protocol. 
When all the chimneys are flowing, the device is ready for operation.

Troubleshooting 
problems

Probable cause and solution

Fluid does not 
flow out of a 
chimney.

A trapped air bubble can block the fluid flow out of a 
chimney.

To clear the bubble:
1 Form a seal between the top of the problematic chimney 

and a 1000-µL pipette, and then draw the liquid out at a 
medium speed. 

2 Run the Startup protocol again to determine if the 
bubble was successfully removed. 

3 Repeat if necessary. 
Chimney 
deformity or 
irregularity

Chimney irregularities can result from a collision between 
the head and the wash station. 
To replace damaged chimneys, see the instructions in the 
96 Channel Wash Station Maintenance Guide.



89

5   Verifying the installation and setup
Testing the safety equipment

 AssayMAP Bravo Platform Installation Guide

Testing the safety equipment

Performing an emergency stop to test the safety equipment

The AssayMAP Bravo Platform has a safety interlock circuit that is designed to protect 
operators from moving-parts hazards. The interlock circuit must be closed for the 
AssayMAP Bravo Platform to operate. The pendant and the Light Curtain are 
connected to the interlock circuit. Pressing the red button on the pendant or 
interrupting the Light Curtain trips the interlock circuit, causing the motion of the Bravo 
head to stop. 

CAUTION
Using the safety interlock to stop the Bravo Platform might result in an interrupted 
protocol run that cannot be resumed or recovered. Do not interrupt the Light Curtain 
or press the red button on the pendant to perform a routine stop. To pause and 
continue a run, use the Pause button in the form. For detailed instructions on how to 
recover from errors, see the AssayMAP Bravo Platform Error Recovery Guide.

To test the emergency stop feature:
1 Open the Utility Library, locate the Cartridge Transfer utility, and then click Utility.
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2 In the A. Application Settings area, specify the following settings for the run: 

3 Click Run Protocol to start the run.
4 As soon as the Bravo head starts to move away from its position above the wash 

station and towards deck location 6, press the red button on the pendant.

The Bravo head stops moving and an error message appears.
5 To recover from the emergency stop:

a At the emergency-stop pendant, turn the red button clockwise. The spring-
loaded button pops up.

b In the AssayMAP Bravo Error dialog box, click Abort to end the protocol.
c Run the Startup utility again to reset the system. For details, see “Running the 

Startup utility” on page 87.
6 Click Run Protocol to start another run.
7 As soon as the Bravo head starts to move away from its position above the wash 

station and towards deck location 6, use a pencil to interrupt the Light Curtain.
The Bravo head stops moving and an error message appears.

8 To recover from the emergency stop:
a Ensure that no objects are in the path of the Light Curtain. 
b In the AssayMAP Bravo Error dialog box, click Abort to end the protocol.
c Run the Startup utility again to reset the system. For details, see “Running the 

Startup utility” on page 87.

Setting Value
First Column in Cartridge Rack 1
Number of Columns to Transfer 12
First Column in Seating Station 1
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Washing the syringes to prepare for first time use

Use the following procedure to prepare the new syringes for use. The procedure primes 
and washes the syringes for 60 cycles.

Before you start

Ensure that you have the following required materials.

Procedure

To prime and wash the syringes:
1 Set up the Wash Buffer Reservoir as follows:

a Fill one of the following labware with the corresponding amount of deionized 
water. 

b Place the filled labware on Bravo deck location 4.

2 Ensure that the deck is clear of other labware, except the wash station at deck 
location 1 and the 96AM Cartridge & Tip Seating Station at deck location 2.
Make sure the 96AM Cartridge & Tip Seating Station empty. (The station should 
not contain cartridges or pipette tips.)

Item Name (manufacturer and part number)

One 
labware for 
wash 
buffer

Use one of the following labware:
• Reservoir, Seahorse 201254-100, PP, no walls, pyramid bottom 

(Agilent 201254-100)
• 12-Column Low-Profile Reservoir (Agilent 201280-100)
• 8-Row Low-Profile PolyPro Reservoir (Agilent 201282-100)

Deionized 
water

Not applicable

Labware Minimum volume (mL)
Reservoir, Seahorse 201254-100, PP, no walls, 
pyramid bottom

50 mL 

12-Column, Low-Profile Reservoir 6 mL/column
8-Row Low-Profile PolyPro Reservoir 8 mL/row
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3 Open the Syringe Wash utility . 

4 In the Labware Table area, select the labware for Deck Location 4 that matches the 
filled labware from step 1. 
Note: Deck locations 3 and 5–9 will not be used in this configuration. Leave the 
labware selections at the default setting for these locations. Do not place 
labware on the deck at these locations.

5 Under Wash Settings, set the following:

                                                        

Setting Value
Initial Syringe Washes 0
Final Syringe Washes 0
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6 For Wash 1, set the following:

7 For Wash 2–Wash 6, set Wash Cycles to 0.
8 Click Run Protocol.
9 After the protocol finishes, leave everything in place, and click Run Protocol again. 
10 After the protocol finishes, leave everything in place, and click Run Protocol for the 

third time.

Performing a test run

To verify that the profile is configured and taught correctly for the installed hardware, 
you should perform a test run of the Affinity Purification protocol. For the test run, you 
use the AssayMAP Resin-Free cartridges instead of packed cartridges, and you do not 
use any labware on the Bravo deck.

Before you start

Ensure that you have the required materials.

Table Required materials

                                                        

Setting Value
Buffer 1
Wash Type Cycle in Reservoir
Volume (µL) 250
Cycles 20
Rinse after Each Cycle Clear the check box
Wash Rate (µL/sec) 200
Wash Cycles 0

Item Part number

AssayMAP Resin-Free cartridge rack 
Note: The protocol will not run if the cartridges are missing. 

IMPORTANT Ensure that these resin-free cartridges are 
not the ones from the AssayMAP Syringe Test Kit. Using 
damaged resin-free cartridges for the AssayMAP syringe test 
could impact the syringe test results.

Agilent 
G5496-60009

Deionized water in the source bottle for the Pump Module Not applicable
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Transferring the cartridges to the 96AM Cartridge & Tip Seating Station

The cartridges must be in the Cartridge & Tip Seating Station before you run the Affinity 
Purification protocol. You can use the Cartridge Transfer utility to move full columns of 
AssayMAP Cartridges from the cartridge rack to the Cartridge & Tip Seating Station.

Before you start
Make sure the Bravo deck is set up as follows:
• The empty Cartridge & Tip Seating Station is at deck location 2. 
• The 96AM Cartridge Rack and Receiver Plate is at deck location 6 and contains 12 

full columns of 8 cartridges each. Make sure you remove the lid.
• The 96AM Wash Station or the later model 96 Channel Wash Station is at deck 

location 1.
• All other deck locations are empty.

Figure Bravo deck layout (top view)

To transfer the cartridges:
1 Open the Utility Library, locate the Cartridge Transfer utility, and then click Utility.
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2 In the Application Settings area, specify the following settings for the run: 

3 Confirm that the physical layout on the AssayMAP Bravo deck matches the Deck 
Layout and Labware Table sections of the form.

4 Ensure that the labware are properly seated in the platepads.

CAUTION
Improperly seated labware can cause a hardware collision, resulting in equipment 
damage. Ensure that all labware are properly seated within the alignment features of 
their respective platepads.

5 Click Run Protocol to start the run.
To monitor the progress of the run, check the Status box in the upper right corner 
of the form.

6 When the run is finished, remove the 96AM Cartridge Rack and Receiver Plate from 
deck location 6.

                                                        

Setting Value
First Column in Cartridge Rack 1
Number of Columns to Transfer 12
First Column in Seating Station 1
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Performing a test run of the Affinity Purification protocol

IMPORTANT
For this test run, you will not use any additional labware. Ensure that the only items on 
the deck are the wash station at deck location 1 and the Cartridge & Tip Seating Station 
containing the Resin-Free cartridges at deck location 2.

To perform a test run of the Affinity Purification protocol:
1 In the Protein Sample Prep Workbench, open the App Library and locate Affinity 

Purification. Click App to open the application.

The Affinity Purification application opens. 

2 Under Select Method, click . In the Open dialog box, locate following folder:

C:/VWorks Workspace/Methods/AM Affinity Purification 2.0
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Select the following method file for the standard size cartridge:
5uL Cartridge Default Settings.js
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In the Affinity Purification form, click Load to display all the settings associated with 
the selected method.

3 Make sure the Status box displays the 5uL Cartridge Default Settings loaded 
successfully message.
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4 Under Application Settings, change the settings as shown in the following figure:

a Set the Number of Full Columns of Cartridges to 12.
b Set the Flow Rate (µL/min) to 500 for each applicable step
c Set the Wash Cycles to 1.

5 In the Labware Table area, use the default settings for the labware selections. 
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6 Click Run Protocol to start the run.
The protocol run starts and checks for conflicting step selections. The protocol 
with the 500-µL/min flow rate should take less than 15 minutes to complete. 

7 During the test run, observe the automation movements of the Bravo 96AM Head 
to assess whether any problems occur. Make a note of any problems. See the 
following table for the sequence of movements.
To monitor the progress of the run, check the Status box.
To pause the run, click Pause. The task currently in progress finishes before the 
protocol pauses.

You can use the Cartridge Transfer utility to transfer the cartridges from the seating 
station back to the cartridge rack.

Table Automation movements during the Affinity Purification protocol

Protocol step Head moves 
to deck 
location...

Action

Start protocol 2 Parks any cartridges that may have been mounted on the head from 
a protocol that had been previously aborted.

1 Dispenses any liquid remaining in the syringes into the wash station.

Initial Syringe Wash 1 Washes the syringes the specified number of times.

Prime
 

3 Aspirates 10 µL of Priming Buffer for the cartridge air-gap 
prevention step.

2 Dispenses the 10 µL of buffer into the cartridge cups and exercises 
the cartridges off task.

3 Aspirates the Priming Buffer.

2 Mounts the cartridges on the head.

1 Dispenses the Priming Buffer through the cartridges into the wash 
station.

2 Parks the cartridges in the seating station.

1 Washes the syringes at the wash station.

Equilibrate 3 Aspirates the Equilibration Buffer.

2 Mounts the cartridges on the head.

1 Dispenses the Equilibration Buffer through the cartridges to 
equilibrate.

2 Parks the cartridges in the seating station.

1 Washes the syringes at the wash station.
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Load Samples 4 Aspirates samples into the syringes.

1 Washes the exterior of the syringe probes at the wash station.

2 Mounts the cartridges on the head.

7 Dispenses sample through the cartridges to load sample. Collect 
flow-through in the Flow Through Collection plate.

1 Washes the cartridge exteriors at the wash station.

2 Parks the cartridges at the seating station.

1 Washes the syringes at the wash station.

Cup Wash 1 5 Aspirates Cartridge Wash Buffer 1 into the syringes.

2 Performs the cup wash and exercises the cartridges off task.

1 Dispenses the buffer at the wash station.

1 Washes the syringes at the wash station.

Internal Cartridge 
Wash 1

5 Aspirates 10 µL of Cartridge Wash Buffer 1 for the cartridge air-gap 
prevention step.

2 Dispenses the 10 µL of buffer into the cartridge cups and exercises 
the cartridges off task.

5 Aspirates Cartridge Wash Buffer 1 into the syringes.

2 Mounts the cartridges on the head.

1 Dispenses 25 µL Cartridge Wash Buffer 1 through the cartridges at 
the Load Samples flow rate for the sample chase step.

1 Dispenses Cartridge Wash Buffer 1 through the cartridges for the 
Internal Cartridge Wash step.

1 Washes the exterior of the cartridge tips at the wash station.

2 Parks the cartridges at the seating station.

1 Washes the syringes at the wash station.

Cup Wash 2 6 Aspirates Cartridge Wash Buffer 2 into the syringes.

2 Performs a cup wash and exercises the cartridges off task.

1 Dispenses buffer at the wash station.

1 Washes the syringes at the wash station.

Protocol step Head moves 
to deck 
location...

Action
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Internal Cartridge 
Wash 2

6 Aspirates 10 µL of Cartridge Wash Buffer 2 for the cartridge air-gap 
prevention step.

2 Dispenses the 10 µL of buffer into the cartridge cups and exercises 
the cartridges off task.

6 Aspirates Cartridge Wash Buffer 2 into the syringes.

2 Mounts the cartridges on the head.

1 Dispenses Cartridge Wash Buffer 2 through the cartridges.

1 Washes the exterior of the cartridge tips at the wash station.

2 Parks the cartridges at the seating station.

1 Washes the syringes at the wash station.

Stringent Syringe 
Wash

8 Aspirates the Stringent Syringe Wash Buffer (Elution Buffer).

1 Dispenses the buffer at the wash station.

1 Washes the syringes at the wash station.

Elute 8 Aspirates the Elution Buffer.

2 Mounts the cartridges.

9 Elutes the samples into the Eluate Collection plate.

1 Washes the cartridge exteriors at the wash station.

2 Parks the cartridges at the seating station.

9 Mixes eluates.

1 Washes the syringes at the wash station.

2 Aspirates excess liquid from the cartridge cups, and exercise the 
Cartridges Off mechanism.

1 Dispenses liquid to waste and perform a syringe wash at the wash 
station.

Final Syringe Wash 1 Washes the syringes at the wash station.

Protocol step Head moves 
to deck 
location...

Action
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Running the Syringe Test utility

You use the AssayMAP Syringe Test Kit to evaluate all the syringes in the head 
concurrently while the Bravo 96AM Head is mounted on the AssayMAP Bravo Platform.

Required reagents, labware, and equipment

Workflow

To run the Syringe Test utility:

1 Open the Utility Library, locate the Syringe Test utility, and then click Utility.

2 Click Instructions.
3 Follow the instructions to run the Syringe Test.
4 If required, replace defective syringes, and then rerun the Syringe Test to confirm 

all the syringes are functioning properly.

Item Required items Description Part number

1 Syringe Test Kit Contains materials and reagents to 
perform 20 tests of the 96 syringes in 
the Bravo 96AM Head.

G5496-60050

2 96-well microplate, 
(2 per test)

Flat bottom, clear polystyrene 
microplate for test sample collection.

• Greiner 655101
• Nunc 269620
• Corning 9017

3 Open reservoir,  
(2 per test)

Open reservoir to hold water and diluted 
test solution.

• Agilent G5498B #049
• Agilent 201254-100
• Axygen RES-SW96-LP

4 Microplate centrifuge Centrifuge with a microplate rotor 
capable of achieving 500 x g

Not applicable

5 Microplate reader Spectrophotometer capable of detecting 
absorbance at 425 nm in a 96-well 
microplate and generating a text (TXT) 
file of the data.
Note: Although 425 nm is optimal, 
405 nm is also acceptable.

NA
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Running the Shutdown utility

You should run the Shutdown utility after every application protocol run, if the 
AssayMAP Bravo Platform will not be in use for 1 hour or longer, and before shutting 
down the device overnight.
The Shutdown utility prepares the AssayMAP Bravo Platform for idle time by:
• Washing the syringes the specified number of wash cycles.
• Aspirating 200 µL of Syringe Storage Liquid into the syringes. The Syringe Storage 

Liquid prevents residual reagents from forming salts and corroding the syringe 
seals. 

Workflow

To run the Shutdown utility:

1 Open the Utility Library, locate the System Startup/Shutdown utility, and then click 
Utility.

2 Click Instructions.
3 Follow the instructions to run the Shutdown utility.
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profile
This appendix contains the following topics:
• “Workflow for setting teachpoints in each profile manually” on page 106
• “Adjusting the teachpoint for the Bravo Plate Riser” on page 107
• “Adjusting the teachpoint for the red PCR plate insert” on page 109
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Workflow for setting teachpoints in each profile manually

About this topic

Every device profile in the Protein Sample Prep Workbench must be adjusted to the 
correct teachpoints of the specific AssayMAP Bravo Platform. You can use the 
following workflow to set the teachpoints for all nine deck locations in every device 
profile manually.
Alternatively, for a semi-automated workflow, see “Teaching part 1: Setting teachpoints 
in AssayMAP 1 profile” on page 62.

Before you start

Ensure that all device profiles in the Protein Sample Prep Workbench have been 
installed, and that they are configured correctly. See “Verifying the profile settings and 
configuration” on page 43.

CAUTION
Using a profile that is associated with teachpoints from a different instrument can 
result in a hardware collision and cause equipment damage. Ensure that you verify 
the teachpoints associated with each profile for your specific instrument and Bravo 
96AM Head.

Workflow for manually setting teachpoints

Step For this task... See...

1 Initialize the AssayMAP 1 profile. “Initializing the profile that you are 
verifying” on page 55

2 In the AssayMAP 1 profile, set the teachpoint for deck 
location 2 and derive the teachpoints for the other eight 
deck locations automatically.

“Teaching part 1: Setting teachpoints 
in AssayMAP 1 profile” on page 62

3 Fine tune the derived teachpoints. “Fine tuning the teachpoints” on 
page 65

4 Normalization profile only. If the Bravo Plate Riser is 
installed at deck locations 2 and 6, adjust the teachpoint at 
these locations to accommodate the extra height.

“Adjusting the teachpoint for the Bravo 
Plate Riser” on page 107

5 GlykoPrep-Plus profile only. If the Peltier Thermal Station is 
installed at deck location 4, adjust the teachpoint to 
accommodate the red PCR plate insert.

“Adjusting the teachpoint for the red 
PCR plate insert” on page 109

6 Orbital Shaking Station only. If the accessory is installed at 
deck location 9, fine tune the teachpoint.

“Teaching the Orbital Shaking Station 
at deck location 9” on page 67

7 Adjust the teachpoint for the 96AM Wash Station. “Teaching the 96AM Wash Station at 
deck location 1” on page 68
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Adjusting the teachpoint for the Bravo Plate Riser

Use the following procedures only if the deck configuration contains the Bravo Plate 
Risers, for example, the AssayMAP Normalization profile.

Bravo Plate Riser description

The Bravo Plate Riser is a 2.84-cm tall deck accessory that you can place atop a 
standard platepad on the Bravo deck. The Bravo Plate Riser requires a teachpoint 
adjustment in the Bravo profile to ensure that the Bravo head moves to the correct 
height at the location where the Bravo Plate Riser is installed. 
The following figure shows the Bravo Plate Riser, which has a crosshairs in one corner 
to facilitate adjusting the teachpoint.

Figure Bravo Plate Riser

CAUTION
Placing the Bravo Plate Riser at a deck location that does not have the corresponding 
teachpoint in the device profile will result in a collision, causing equipment damage. 
Ensure that the device profile includes the corresponding teachpoint for any deck 
location where the Bravo Plate Riser is installed. 

About the AssayMAP Normalization profile

The AssayMAP Normalization profile (Normalization-AM Bravo.dev) includes 
teachpoints for the Bravo Plate Riser at deck locations 2 and 6. However, you should 
adjust the teachpoints on your instrument and verify the teachpoints before running 
the Normalization application for the first time.

8 Adjust the teachpoint for the 96AM Cartridge & Tip Seating 
Station.

“Adjusting the teachpoint at deck 
location 2 for the Cartridge & Tip 
Seating Station” on page 71

9 Adjust the gripper y-axis offset. “Checking and adjusting the gripper 
offset” on page 77

10 Repeat steps 1 to 9 for every device profile in the Protein 
Sample Prep Workbench.

—

Step For this task... See...
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Figure Normalization profile Bravo Plate Riser deck locations 

IMPORTANT
When setting the teachpoint, ensure that a 250-µL pipette tip is seated on probe A1 
(back left corner) of the Bravo 96AM Head.

Adjusting the teachpoint for the Bravo Plate Riser

Use the following procedure to adjust a standard platepad teachpoint to accommodate 
the Bravo Plate Riser. 

To adjust the teachpoint for the Bravo Plate Riser:
1 Place the Bravo Plate Riser on the platepad at the corresponding deck location. 

Ensure that the Bravo Plate Riser is oriented so that the crosshairs is at the back 
left corner. 
Press down on the Bravo Plate Riser so that it is seated on the platepad. 

2 In the Jog/Teach tab, click the Location list, and then select the deck location that 
you are teaching.

3 In the Approach height above teachpoint box, type 50, and then click Approach.
The Bravo head moves to the selected deck location, and then moves down so that 
the tip is approximately 22 mm above the crosshairs on the Bravo Plate Riser. 

4 Carefully, use the Jog Axes controls to move the head down in smaller and smaller 
increments until the pipette tip is about 1 mm above the crosshairs on the Bravo 
Plate Riser.
Visually inspect the alignment to determine if the left-to-right (X) and front-to-back 
(Y) positions of the tip are centered above the crosshairs on the Bravo Plate Riser. If 
necessary, use the Jog Axes controls (Left, Right and Forward, Back) to center the 
A1 tip above the crosshairs.

5 Carefully, use the Jog Axes controls to move the head down in tiny increments until 
the pipette tip is as close as possible to the crosshairs on the Bravo Plate Riser 
without touching the surface. 

6 Click Teach to set the new teachpoint values for the deck location.
7 To save the new teachpoint for this location, click the Profiles tab, and then click 

Update this profile.

00240
Bravo
Plate Orientation

1 2 3

4 5 6

7 8 9
00240
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8 Repeat this procedure for the other deck location where the Bravo Plate Riser will 
be installed.

Verifying the teachpoint for the Bravo Plate Riser

Use the following procedure to verify the adjusted teachpoint for the Bravo Plate Riser.

1 Ensure that the Bravo Plate Riser is securely seated on the platepad at the 
corresponding deck location. Ensure that the Bravo Plate Riser is oriented so that 
the crosshairs is at the back left corner. 

2 In the Jog/Teach tab, click the Location list, and then select the deck location you 
are teaching.

3 Click Move, The Bravo head moves to the selected deck location so that the tip is at 
the crosshairs on the Bravo Plate Riser. 

4 Visually inspect the alignment to ensure that the tip is centered from left to right 
and front to back.

CAUTION
A hardware collision can occur if you initialize a device profile that does not include 
the teachpoints for the Bravo Plate Riser while the Bravo Plate Riser remains on the 
deck. Ensure that you remove the Bravo Plate Riser from the deck when initializing a 
different device profile. 

 

Adjusting the teachpoint for the red PCR plate insert

About this topic

Use the following procedure only if the deck configuration includes the Peltier Thermal 
Station and you plan to use the red PCR plate insert. 
The AssayMAP GlykoPrep-plus applications require the red PCR plate insert to be 
present in the plate nest of the Peltier Thermal Station for the entire workflow. Use the 
following teaching procedure to accommodate this requirement for deck location 4 in 
the GlykoPrep-plus profile.

Figure PCR plate insert

IMPORTANT
Ensure that the PCR plate insert is not installed in the Peltier Thermal Station at deck 
location 4 for the following teaching procedure.
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Adjusting the teachpoint for the PCR plate insert

To adjust the teachpoint for the PCR plate insert:
1 In the Jog/Teach tab, click Location 4.

2 Click Move to move the head to the previously defined teachpoint for location 4.
3 Using the Jog Axes controls, jog the head up (-Z) by exactly 4.4 mm. 

For example, if the value for the teachpoint’s Z-axis coordinate from the fine tuning 
was 104.00 mm, the new value after adjusting by 4.4 mm will be 99.60 mm.

4 Click Teach to set the new teachpoint.
5 To save the new teachpoint for this location, click the Profiles tab, and then click 

Update this profile.
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